## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>i</td>
</tr>
<tr>
<td>Preface</td>
<td>vii</td>
</tr>
<tr>
<td>Purpose</td>
<td>vii</td>
</tr>
<tr>
<td>Audience</td>
<td>vii</td>
</tr>
<tr>
<td>Organization</td>
<td>vii</td>
</tr>
<tr>
<td>Related Documentation</td>
<td>viii</td>
</tr>
<tr>
<td>Product Naming Conventions</td>
<td>viii</td>
</tr>
<tr>
<td>Conventions</td>
<td>ix</td>
</tr>
<tr>
<td>Obtaining Documentation and Submitting a Service Request</td>
<td>x</td>
</tr>
<tr>
<td>Documentation Feedback</td>
<td>x</td>
</tr>
<tr>
<td>1. Unified CCMP Overview</td>
<td>11</td>
</tr>
<tr>
<td>Operational Overview</td>
<td>11</td>
</tr>
<tr>
<td>2. Basic Administration Tasks</td>
<td>12</td>
</tr>
<tr>
<td>Configuration of Unified CCMP Security</td>
<td>12</td>
</tr>
<tr>
<td>First Steps for Host Administrators</td>
<td>13</td>
</tr>
<tr>
<td>Configuring Imported Resource Data</td>
<td>13</td>
</tr>
<tr>
<td>Equipment Mapping</td>
<td>13</td>
</tr>
<tr>
<td>Automatic Resource Movement</td>
<td>13</td>
</tr>
<tr>
<td>Shared Remote Resources</td>
<td>14</td>
</tr>
<tr>
<td>Creating a Tenant Administrator</td>
<td>14</td>
</tr>
<tr>
<td>Assigning Administrator Privileges</td>
<td>15</td>
</tr>
<tr>
<td>Using the Agent Password Reset Utility</td>
<td>15</td>
</tr>
<tr>
<td>To change a password</td>
<td>16</td>
</tr>
<tr>
<td>Password Complexity Rules</td>
<td>16</td>
</tr>
<tr>
<td>Unified CCE Password Compliancy</td>
<td>16</td>
</tr>
</tbody>
</table>
3. System Architecture .................................................................................... 17
   Web Application .......................................................................................... 18
   Application Server ....................................................................................... 18
   Data Import Server ...................................................................................... 18
   Provisioning Server ..................................................................................... 18
   High Availability .......................................................................................... 19
      Application Server to Database Connections ........................................... 19
      Database Server Component Failover ....................................................... 20

4. Integrated Configuration Management .................................................... 21
   Integrated Configuration Environment (ICE) ............................................ 21
      Description .............................................................................................. 21
      ICE User Interface .............................................................................. 21
      Starting ICE ....................................................................................... 22
      ICE User Interface ........................................................................... 22
      ICE Menu and Toolbar .................................................................... 23
      ICE Tool Selection ........................................................................... 23
      ICE Tool Area ................................................................................... 24
      ICE Output Pane ............................................................................... 25
   Cluster Configuration .................................................................................. 26
      What the Tool Provides .................................................................... 26
      Cluster Configuration Model .............................................................. 27
      Equipment Mappings ......................................................................... 27
      Impact on Importer Behavior ............................................................... 27
      Impact on User Interface ................................................................... 28
      Changing Ownership by Moving Items ................................................ 29
      Importing Remote Ownership Changes ................................................ 30
      Using the Cluster Configuration Tool ................................................... 30
      Cluster Configuration Actions ............................................................... 30
      Cluster Configuration Preferences ......................................................... 31
      Cluster Configuration Filters ................................................................ 32
      Cluster Configuration User Interface .................................................... 33
      Cluster Configuration Error List Pane .................................................... 34
      Setup Page .......................................................................................... 35
      Servers Page ......................................................................................... 35
      Resources Page .................................................................................... 37
      Logical Resources .............................................................................. 39
      Properties of Logical Resources .......................................................... 39
      Physical Resources ............................................................................. 42
      Properties of Physical Resource Objects .............................................. 43
      Properties of Physical Resource Components ..................................... 46
      Diagnostic Portal Support ................................................................. 48
      Cluster Configuration Connection Support .......................................... 49
Equipment Mappings Page ...................................................... 55
Connections Page ................................................................. 56

Replication Manager .............................................................. 59
  What the Tool Provides ....................................................... 59
  Using the Tool ..................................................................... 60
  Setup .................................................................................. 60
  Monitor .............................................................................. 62

Failover Manager ................................................................... 64
  What the Tool Provides ....................................................... 64
  Using the Tool ..................................................................... 64
    Preparing to Use the Failover Manager ......................... 64
    Starting the Failover Manager Tool ......................... 64
    Performing a Failover Operation ............................. 65
  Failover Actions .................................................................... 68
    Provisioning Service ...................................................... 68
    Data Import Server Service .............................................. 68

Service Manager .................................................................... 68
  What the Tool Provides ....................................................... 68
  Supported Services .......................................................... 68
  Using Service Manager ....................................................... 69
    Starting the Service Manager Tool ............................. 69
    Starting Services .......................................................... 69
    Stopping Services .......................................................... 69
    Restarting Services ......................................................... 70
    Sorting Services ............................................................. 70
    Filtering Services ............................................................ 70
    Shortcut Menu .................................................................. 71

System Properties Manager .................................................. 71
  What the Tool Provides ....................................................... 71
  Using System Properties Manager ................................. 71
    Starting the System Properties Manager Tool ..................... 71
  System Properties ........................................................... 72
    Global Properties Tab ...................................................... 72
    Local Properties Tab ....................................................... 78
    Resource Properties Tab .................................................. 78
    Capacity Properties Tab .................................................... 79

5. Remote Resource Provisioning ............................................ 81

System Management ............................................................ 81

Remote Resource States ....................................................... 81
  State Descriptions ........................................................... 82
    Pending Active ............................................................. 83
    Ready ............................................................................ 83
    Error ............................................................................. 83
Delete Pending ................................................................. 83
Deleted ............................................................................. 84
User Interface ................................................................. 84
Database Codes ............................................................ 84
Memberships ................................................................. 85
State Machine Scenarios .................................................. 85

Provisioning Non-CCE Peripheral Types ......................... 86

Unified CCE Purge Logic .................................................. 87

Mobile Agent Support .................................................... 88
  About Mobile Agents .................................................. 88
  Configuring Mobile Agent Support in Unified CCE ........ 88
  Configuring Mobile Agents ......................................... 88
    About Configuring Mobile Agents ............................. 88
    Configuring the Agent Desk Settings for Mobile Agents ...................................................................... 89
    Configuring CTI Ports and Device Targets for Mobile Agents ............................................................. 89

Partitioned Internet Script Editor ........................................ 90
  About the Partitioned Internet Script Editor ................. 90
  Configuring ISE Integration with Unified CCMP .......... 90
    About the Configuration Steps ................................. 90
    Configuring Internet Script Editor to use Unified CCMP ................................................................. 90
    Security Partitioning ............................................... 90
    Creating a Linked Unified CCE and Unified CCMP User ................................................................. 91

Supported Objects ........................................................ 93
Troubleshooting ISE Integration with Unified CCMP .......... 94
  Error Reporting ......................................................... 94
  Error when starting ISE ............................................. 94
  Failed to connect to Authorization Server .................... 95
  Unable to see required resources .............................. 99

6. Auditing and Monitoring .............................................. 101

Audit Histories .............................................................. 101
  Resource Audit History .............................................. 101
  Activity Monitor ....................................................... 101

Logging ................................................................. 101
  Application Server Log ............................................. 102
  Web Application Log ............................................... 103
  Data Import Server Log .......................................... 103
  Provisioning Server Log .......................................... 103
  Partitioning Log ...................................................... 103
  Installer Logs ......................................................... 103
  IIS Log Files ......................................................... 103

Performance Counters .................................................. 104
  Unified CCMP Data Pipeline Object .......................... 104
Unified CCMP Application Server Object ........................................ 105
Unified CCMP Provisioning Object ................................................. 106
Unified CCMP <Service Type> Connection Health Object ........... 106
Unified CCMP <Service Type> Connection Requests .................. 106

Configuring SNMP Traps ................................................................. 106
  Enable the Windows SNMP Feature ......................................... 107
  Configure the SNMP Service for Trap Forwarding .................. 107
  Configure Windows Events to forward to SNMP ..................... 108

7. Standard Administrative Operations ........................................... 109

Service Restart Configuration ....................................................... 109

Resetting Default Database Connections ................................... 109
  Connection Updater Features ............................................... 110
  Connection Updater Usage .................................................. 111
  Testing Connections ......................................................... 112
  Restart Services .................................................................. 112

8. Advanced Administrative Operations ........................................ 113

Enabling and Disabling Cluster Configuration Components .......... 113

Database Backup and Recovery ................................................... 114

9. Troubleshooting ........................................................................ 115

DBCheck ..................................................................................... 115
  Overview ............................................................................... 115
  Architectural Background .................................................... 116
  Installation ........................................................................... 116
  Configuration ....................................................................... 116
  Running DBCheck .............................................................. 118
  Logging and Error Reporting ................................................. 120
  Reviewing Logs ................................................................. 120
  Troubleshooting DBCheck .................................................... 120

Unified System CLI ................................................................. 121
  About Unified System CLI .................................................... 121
  Installing Unified System CLI ............................................... 121
  Starting Unified System CLI .................................................. 121
  Getting Help ........................................................................ 121
  Unified System CLI Command Reference .............................. 122

General Troubleshooting ............................................................ 124
  Delays in Importing Agent Changes ..................................... 124
  Web Portal Timing Dialogs .................................................... 124
  Installing the UCCE Config Web Service Certificate .......... 124
Installing the Security Certificate in the User Certificate Store 125
Installing the Security Certificate in the Computer Certificate Store .............................................................. 126
Installing the Security Certificate for ICE Users ................ 127
Unable to Associate Domain User Account with a Supervisor .... 127
Preface

Purpose

This document explains how to administer and provision the Unified Contact Center Management Portal (Unified CCMP) platform.

Audience

This document is intended for all users of Unified CCMP, from high-level administrators to team supervisors. The reader needs no technical understanding beyond a basic knowledge of how to use computers.

Organization

The sections of this guide are as follows:

Chapter 1 Unified CCMP Overview
This chapter provides a general overview of Unified CCMP

Chapter 2 Basic Administration Tasks
This chapter explains the basic principles behind the day-to-day administration tasks required for unified CCMP to

Chapter 3 System Architecture
This chapter gives an overview of the Unified CCMP system architecture

Chapter 4 Integrated Configuration Management
This chapter explains how to use the tools in the Integrated Configuration Environment to configure Unified CCMP.

Chapter 5 Remote Resource Provisioning
This chapter explains how remote resources are provisioned by Unified CCMP.

Chapter 6 Auditing and Monitoring
This chapter describes the auditing and monitoring features in Unified CCMP.

Chapter 7 Standard Administrative Operations
This chapter describes standard administration operations.

Chapter 8 Advanced Administrative
This chapter describes some advanced
Operations administration operations.

Chapter 9 Troubleshooting This chapter provides some troubleshooting advice.

Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at:


- Related documentation includes the documentation sets for Cisco CTI Object Server (CTIOS), Cisco Agent Desktop (CAD), Cisco Agent Desktop - Browser Edition (CAD-BE), Cisco Unified Contact Center Management Portal, Cisco Unified Customer Voice Portal (CVP), Cisco Unified IP IVR, Cisco Unified Intelligence Center, and Cisco Support Tools.

- For documentation for these Cisco Unified Contact Center products, go to http://www.cisco.com/cisco/web/psa/default.html, click Voice and Unified Communications, then click Customer Contact, then click Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click the product/option you are interested in.

- For troubleshooting tips for these Cisco Unified Contact Center products, go to http://docwiki.cisco.com/wiki/Category:Troubleshooting, then click the product/option you are interested in.

- Documentation for Cisco Unified Communications Manager is accessible from:

- Technical Support documentation and tools are accessible from:

- The Product Alert tool is accessible from (sign in required):
  http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.

- For information on the Cisco software support methodology, refer to Software Release and Support Methodology: ICM/IPCC available at (sign in required):

For a detailed list of language localizations, refer to the Cisco Unified ICM/Contact Center Product and System Localization Matrix available at the bottom of the following page:


Product Naming Conventions

In this release, the product names defined in the table below have changed. The New Name (long version) is reserved for the first instance of that product name and in all
headings. The New Name (short version) is used for subsequent instances of the product name.

Note This document uses the naming conventions provided in each GUI, which means that in some cases the old product name is in use.

<table>
<thead>
<tr>
<th>Old Product Name</th>
<th>New Name (long version)</th>
<th>New Name (short version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IPCC Enterprise Edition</td>
<td>Cisco Unified Contact Center Enterprise</td>
<td>Unified CCE</td>
</tr>
<tr>
<td>Cisco IPCC Hosted Edition</td>
<td>Cisco Unified Contact Center Hosted</td>
<td>Unified CCH</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM)</td>
<td>Cisco Unified Intelligent Contact Management (ICM)</td>
<td>Unified ICM</td>
</tr>
<tr>
<td>Enterprise Edition</td>
<td>Enterprise</td>
<td></td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM)</td>
<td>Cisco Unified Intelligent Contact Management (ICM)</td>
<td></td>
</tr>
<tr>
<td>Enterprise Hosted Edition</td>
<td>Hosted</td>
<td></td>
</tr>
<tr>
<td>Cisco CallManager/Cisco Unified CallManager</td>
<td>Cisco Unified Communications Manager</td>
<td>Unified CM</td>
</tr>
</tbody>
</table>

Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface font</strong></td>
<td>Boldface font is used to indicate commands, such as entries, keys, buttons, folders and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose Edit &gt; Find</td>
</tr>
<tr>
<td></td>
<td>• Click Finish</td>
</tr>
<tr>
<td>italic font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term; for example: <em>skill group</em> is a collection of agents who share similar skills</td>
</tr>
<tr>
<td></td>
<td>• For emphasis; for example: <em>Do not</em> use the numerical naming convention</td>
</tr>
<tr>
<td></td>
<td>• A syntax value that the user must replace; for example: IF (<em>condition</em>, <em>true-value</em>, <em>false-value</em>)</td>
</tr>
<tr>
<td></td>
<td>• A book title; for example: Refer to the <em>User Guide for Cisco Unified Contact Center Management Portal</em></td>
</tr>
<tr>
<td>window font</td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
</tbody>
</table>
Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

Documentation Feedback

You can provide comments about this document by sending an email message to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
1. Unified CCMP Overview

Operational Overview

The Unified Contact Center Management Portal (Unified CCMP) is a suite of server components that simplify the operations and procedures for performing basic administrative functions such as managing agents and equipment.

Unified CCMP consists of the following components:

- The **Database Server** component holds information about all the resources (such as agents and dialed numbers) and actions (such as phone calls and agent state changes) within the system.

- The **Application Server** component manages security and resilience, enabling one side of a dual-sided Unified CCMP to use the other side’s servers if one of the servers or connections fails.

- The **Web Server** component provides the user interface that enables users to perform resource management and administrative tasks.

- The **Data Import Server** component imports resources (for example Agents, Skill Groups) into the Unified CCMP Database and synchronizes changes made to those resources outside of the Unified CCMP environment.

- The **Provisioning Server** component provides the mechanism to commit resource changes made by Unified CCMP users to back-end contact center systems, for example the Cisco Unified Contact Center Platform.

These components are normally installed on more than one machine.
2. Basic Administration Tasks

Unified CCMP is a browser-based management application designed for use by contact center/system administrators, business users and supervisors. The Host Administrator user is created when the application is installed. This user does not manage the Unified CCMP application on a day-to-day basis, but will set up tenant administrator users to do so for each configured tenant in the system.

Configuration of Unified CCMP Security

The Unified CCMP web application has a typically small number of different user types:

- **Host Administrator** is responsible for the whole platform and therefore has a view across all the equipment and resources.
- **Tenant Administrator** is responsible for the slice of the system assigned to the tenant by the host administrator.
- **Tenant User** has access only to the resources and tools assigned by the tenant administrator. Several sub-classes of tenant user may be created by the tenant administrator using user groups and roles to achieve their business requirements.
- **Supervisor User** has access to one or more Agent Teams that they supervise in the contact center. They will have permissions to create Agents and assign them to Teams and Skill Groups.

On a new system the Host and Tenant Administrators perform their respective tasks before the Tenant and Supervisor users are given access to the system.

A host administrator is responsible for global platform security management, whereas a tenant admin will be responsible for security management of only the resources in their domain. Security management can be thought of as the process of determining which users can perform which actions in which folders.

This involves creating and managing the following entities:

- **Folders.** The security system used by Unified CCMP is based on a hierarchical folder structure where child folders may inherit permissions from their parent. This means that the folder hierarchy should ideally be designed with security requirements in mind.
- **Users and Groups.** Users can be assigned to groups of users with the same security permissions. A number of predefined groups with commonly required permissions are provided.
- **Roles and Tasks.** Control the actions that can be performed within a folder. Each task is an individual kind of action, such as browsing resources or managing information notices. These tasks are collected together into roles. For example,
you could create an Auditor role that included the ability to manage audit reports, browse audit reports, and browse resources, and then assign certain groups or even individual users the permission to perform that role within certain folders.

For each role a user or group is assigned, they must also be assigned an equivalent global role. Removing a global role removes that user’s ability to perform the corresponding non-global roles anywhere within the system, meaning it is possible to remove permissions in a single click where necessary. The default groups have the correct global permissions pre-assigned.


First Steps for Host Administrators

The Host administrator is responsible for:

- Ensuring that the remote resources (such as Skill Groups, Agents and Call Types) are correctly located in the tenant folder
- Creating a Tenant Administrator user for each tenant
- Adding them to the administrators group for the tenant and assigning any specific roles

Configuring Imported Resource Data

After the initial data import, remote resources imported from Unified CCE and Unified CM are associated with their respective tenants and will be automatically stored in their associated folders.

Equipment Mapping

After installation the host administrator should configure the remote equipment mappings for the system so that resources are placed in the appropriate segregated tenant folders.

An equipment mapping provides a link between a folder in Unified CCMP and the remote equipment, telling the Unified CCMP importer where resources should be placed. You can access provision equipment mappings through the Cluster Configuration tool of the Integrated Configuration Environment (ICE) by selecting the Equipment Mapping option.

For more information about using the Cluster Configuration tool to do equipment mappings, see section Equipment Mappings Page below.

Automatic Resource Movement

Prefixes may be used to manage the automatic movement of remote resources to associated folder locations.
To map a prefix to a tenant for the importing of Unified CCE or Unified CM data, the user must have host administrator privileges.

You can only map a prefix to a tenant folder. Any individual item moved to a folder is then excluded from the prefix management import job to prevent it from being automatically moved by the system.

Additional information on creating Prefixes is available in the User Guide for Cisco Unified Contact Center Management Portal.

Shared Remote Resources

Where multiple tenants share a Unified CCE or Unified CM then resources will be put into the system unallocated folder. An administrator must then place these remote resources into the appropriate tenant folder through either the Unified CCMP user interface or through the use of Unified CCMP Prefix mappings. Related resource items, such as IP Phones and their Directory Numbers or Agents and their associated Person should be moved to the same folder.

Resources associated with more than one tenant, such as peripherals, media routing domains and phone types should be placed in a folder that should be readable by users from those tenants. More information on how to manage security in Unified CCMP can be found in the User Guide for Cisco Unified Contact Center Management Portal.

Creating a Tenant Administrator

1. Click Tools link at the top right of the web page to display the Tools page.
2. In the Security Manager section, click User Manager.
3. Click Users tab to access the User Browser page.
4. Select the tenant folder and click New.
5. Fill in the following fields:
   - User Name field enter the name as it will appear in the system for the new user
   - Password field enter the password for the new user
   - Confirm Password field re-enter the selected password
   - First Name and Last Name fields enter the user's details
   - Email field enter the email address of the new user
   - Description field enter any explanatory text, if required
6. Select Advanced Mode checkbox and any of the following checkboxes if applicable:
Chapter 2: Basic Administration Tasks

Using the Agent Password Reset Utility

- **Enabled** checkbox to ensure that the user is live in the system. If unchecked the new user exists in the system, and so can be granted security permissions, but cannot log in
- **User must change password at next Logon** checkbox to prompt the new user to change their password after their first login
- **Password Never Expires** checkbox to assign the password to the new user indefinitely
- **User cannot change password** checkbox to prevent the new user from being able to change their password

Only the User Name, Password and Confirm Password fields are required.

7. Click **OK**.

Assigning Administrator Privileges

Now you must give the tenant administrator the permissions necessary to manage the system. This is done by assigning the new user to the administration group that was automatically created when you created the tenant.

1. In the User Manage, click **Administrator User** to display the Edit User page.
2. Click **Groups** tab.

All users created are automatically assigned to the group Everyone.

3. Select **Advanced Users**. The user’s permissions are automatically updated so that they can manage users, folders, information notices and folder security within the tenant folder.

It is possible to create your own groups with custom permissions, or to grant specific permissions to individual users. See the Security Management section of the **User Guide for Cisco Unified Contact Center Management Portal** for details.

Using the Agent Password Reset Utility

Cisco Unified CCMP provides a Change Your Agent Password utility from which agents can change their own passwords.

This page is reached by navigating to the URL: [Hhttp://<CCMP Server>/Portal/agent_manage_password.aspx](http://<CCMP Server>/Portal/agent_manage_password.aspx). You do not need to have a Portal user account to use the Change Your Agent Password page.
To change a password

1. Enter the Agent Username. This is the login name that you use to log into the peripheral.
2. Enter the Agent’s current password.
3. Enter your new password for the Agent, and confirm.

Password changes are subject to a small time delay while they are committed to Cisco Unified CCE.

Password Complexity Rules

Passwords for agents must conform to the password complexity rules defined in the Cisco Unified CCMP.

The following settings can be configured:

- Password Format.
- Minimum Password Length.
- Maximum Password Length.

For more information about changing the password complexity rules in Cisco Unified CCMP, please refer to the section on Security Settings located in the User Guide for Cisco Unified Communications Management Portal.

Unified CCE Password Compliance

When using the resource management functionality of Unified CCMP to configure Agent and Person entries Unified CCMP will prompt the end user for the entry of logon credentials that agents will use to logon to their equipment.

Minimum length rules applied in Unified CCE will be honored through the Unified CCMP Web User Interface to ensure that agents created/edited within Unified CCMP may logon to their equipment with no further change.

Unified CCE provides the ability to set the minimum password length by accessing the System Information section of Configuration Manager on the AW.
3. System Architecture

The Unified CCMP system architecture is shown below. The top half of the diagram is a traditional three-tier application. This includes a presentation layer (an ASP.NET web application), a business logic application server, and a SQL Server database. The lower half of the system architecture is a process orchestration and systems integration layer called the Data Import Server and the Provisioning Server provisioning connection to Unified Communications Manager (Unified CM) and Unified CCE.

Figure 3-1 Unified CCMP Architecture
Web Application

The user interface to Unified CCMP is by a web application that is accessed by a web browser (Microsoft Internet Explorer). Access is gained through a secure login screen. Every user has a unique user name. This user name is assigned privileges by the system administrator, which defines the system functions the user can access and perform.

The web application is hosted on the server by Microsoft Internet Information Services (IIS).

Application Server

The Unified CCMP Application Server component provides a secure layer in which all business logic is implemented. The application server component runs in a separate service and is always hosted with the web server component. The application server component also includes caching to improve performance and audits all actions taken by logged in users.

Data Import Server

The Data Import Server component is an Extract, Transform and Load application for Unified CCMP. The Data Import Server component imports the data used in Unified CCMP.

The Microflow Runtime is the heart of the Data Import Server component. It orchestrates systems without resorting to low level programming languages. The Microflow Runtime is a general purpose scripting environment and can be applied to a wide range of problems. The term microflow describes any modular, reusable and independent unit of business logic. An example microflow might update an agent on the Cisco Unified CCE platform when changes are made through Unified CCMP web server component.

Provisioning Server

The Provisioning Server component is also responsible for monitoring changes in the Unified CCMP system and ensuring that those changes are updated onto Unified CCE. The provisioning server component orchestrates the creation, deletion and update of resources to Unified CCE and Unified CM.

The Unified CCMP Provisioning Service utilizes the Unified CCE ConAPI interface to commit changes to the Unified CCE.

Provisioning changes are managed via periodic cycles performed by the provisioning server. After a change has been committed by the ConAPI interface the Provisioning Server will wait a configurable period of time (5 seconds by default), before moving onto the next operation. This configurable throttle reduces the possibility of overloading Unified CCE during busy times.
The provisioning characteristics of this service are as follows:

- For Agent > Skill Group relationships, the provisioning server will batch together up to 100 requested operations into one request executed every provisioning cycle.

- For all other items (for example Agents, Agent Teams and so on), all items and relationships are treated as separate provisioning operation. These are executed one by one honoring the configured provisioning throttle between operation executions.

- By default this would mean that the creation of an Agent that is linked to one Agent Team and two Skill Groups would create the following provisioning operations:
  - Agent Creations
  - Agent to Agent Team relationship
  - Bulk Agent to Skill Group relationship

High Availability

The Unified CCMP software provides a high-availability deployment option to ensure that in the event of failure the system will remain operational and able to support end user requests.

The high availability model is implemented across all components in the system. Some components provide an automated failover and others require manual intervention to restore operation.

The Unified CCMP High Availability model is an Active – Active model, where all Unified CCMP and dependent services should be active and running under standard operation.

Application Server to Database Connections

In a high availability deployment, there are two Database Servers. These database servers have their information replicated using SQL Server Transactional Replication. If a failure occurs on one side of the system then all data up to the point of failure will have been replicated on the other database server.

The Application Servers test the databases periodically to identify health. If both databases are healthy then the Application Server will connect to the local Database Server. If one of the database health checks fails then the Application Server will automatically switch the connection to the other Database Server. There may be a minor loss of service whilst the monitoring test and connection switch occurs, but the Application Server will restore service to end users automatically once the next test is performed.
Database Server Component Failover

The Database Server contains the Data Import Server and Provisioning Server components of Unified CCMP. These components are essential to the standard operation of Unified CCMP.

- The Data Import Server imports resources from the AW into the Unified CCMP database.
- The Provisioning Server sends changes made in Unified CCMP (via the Web Service APIs, or the web application) to Unified CCE.

Both the Data Import Server and the Provisioning Server monitor the connection to the Unified CCE AW (or AWs) which they are configured to provision to. If one of these tests fails, both services will automatically switch to perform import and provisioning activity from the other side of Unified CCE.

Under normal operation, the Data Import Server and Provisioning Server will be running on both sides of the Unified CCMP system. Both will maintain the required connections to the AW which they then use for importing and provisioning. One side of the Unified CCMP system will be marked as active and one side will be disabled. This means that all provisioning and import activity is performed on only one of the database servers.

It is a manual process to move provisioning and import activity to the other Database Server in a Unified CCMP installation. The user can use the ICE Failover Manager to perform this operation (see Failover Manager on page 64).

Provisioning and import activity must always be performed on the same server. This is to avoid race conditions during high volume provisioning operations.
Chapter 4: Integrated Configuration Management

Integrated Configuration Environment (ICE)

Description

The Integrated Configuration Environment (ICE) application is a centralized tool that provides easy access to most of the configuration options available within the Unified CCMP platform. Individual configuration tools are components within ICE.

The ICE application supplied with Unified CCMP has the following components:

- **Cluster Configuration**
  Provides functionality for configuring the network topology used by the Unified CCMP system. This tool enables configuration of servers, resources (for example, Unified CCMP components, Unified CCE components) and the connections between them. It also provides monitoring capabilities.

- **Replication Manager**
  Provides functionality for configuring and monitoring SQL Server replication between Unified CCMP databases.

- **Failover Manager**
  Provides functionality for performing manual switchover of the Data Import and Provisioning services between two servers.

- **Services Manager**
  Provides functionality for monitoring and controlling all Unified CCMP services across servers from a single centralized location.

- **System Properties Manager**
  Provides functionality for configuring system wide properties that control a variety of Unified CCMP components.

The ICE tool and the components above are installed as part of the Unified CCMP component installation (see the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal for more information about the Unified CCMP component installation).

ICE User Interface

ICE has a common user interface for all ICE tools.
Starting ICE

1. To start ICE, click Start > All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment. The Database Connection dialog box is displayed.

2. Enter the credentials for your database. To test the validity of the connection, click Test. Click OK to continue.

3. If there are errors or warnings in the configuration when you start ICE, you will see a dialog box stating the number and type of errors and warnings. If this dialog box is shown, click OK.

4. ICE starts in the Cluster Configuration tool. If there were errors or warnings in the configuration, then the error details are shown in the Cluster Configuration Error List pane.

When ICE starts, the Error List pane shows both connection errors and validation errors. Subsequently, the Error List pane only shows validation errors. But the connection status can be seen at any time on the Connections page.

ICE User Interface

The ICE user interface is shown in Figure 4-1. This example shows the ICE Cluster Configuration tool.

Figure 4-1 ICE User Interface
Chapter 4: Integrated Configuration Management

Integrated Configuration Environment (ICE)

ICE Menu and Toolbar

Common actions are visible in the menu and the tool bars at the top of the screen. The common actions supported by ICE are as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save Icon]</td>
<td>Save</td>
<td>Save any changes.</td>
</tr>
<tr>
<td>![Exit Icon]</td>
<td>Exit</td>
<td>Close the ICE application.</td>
</tr>
<tr>
<td>![Preferences Icon]</td>
<td>Preferences</td>
<td>View the ICE tool and component preferences.</td>
</tr>
<tr>
<td>![View Output Icon]</td>
<td>View Output</td>
<td>View the standard output feedback window.</td>
</tr>
<tr>
<td>![Undo Icon]</td>
<td>Undo</td>
<td>Undo the last change.</td>
</tr>
<tr>
<td>![Redo Icon]</td>
<td>Redo</td>
<td>Redo the last change.</td>
</tr>
</tbody>
</table>

- Configured actions may be shown in the menu, the tool bar or both. Generally, commonly used actions (for example, Undo, Redo) are displayed in both the tool bar and the menu, and less commonly used actions just appear in the menu.
- As an example, consider the File action shown in Figure 4-2. Save and Open are shown on both the menu and tool bar, whereas Exit and Preferences are only shown in the menu. The ICE tool in this example is the System Properties tool.

Figure 4-2 Common File Actions

ICE Tool Selection

The ICE application toolbar contains a drop down list below the menu (see Figure 4-3). This contains the available ICE tools. To start an ICE tool, select it from the drop down list.
ICE Tool Area

The central area of the ICE application is used by each ICE tool for their own interface. Figure 4-4. shows the central pane for the ICE System Properties tool.
ICE Output Pane

The bottom area of the ICE application contains an output pane showing the output from the active ICE tools. This area also contains any additional output panes from specific ICE tools.

If both the ICE output pane and a specific output pane are available, they are shown one on top of the other, with a tab to select the one that is visible. Figure 4-5 shows the ICE output pane and the error list pane from the ICE Cluster Configuration tool. In this example, the ICE output pane is currently visible.
You can control the display of the output panes in the following ways:

- You can change the height of the whole area by dragging the top edge up or down using the mouse.
- You can close the current pane, by clicking on the cross at the top right of the pane.
- You can show or hide any currently available pane from the View menu.

You can control the output that is shown in the ICE output pane as follows:

- Click on the **Show output from** drop down list at the top left of the pane to show output from one ICE tool or from all ICE tools. In the example in Figure 4-5 the output pane is showing the output from the Cluster Configuration tool only.
- Click on the **Level** drop down list to choose the level of output you want to see. In the example in Figure 4-5 the output pane is showing the information level output messages.

**Cluster Configuration**

**What the Tool Provides**

The Unified CCMP Cluster Configuration tool is an ICE tool that allows the administrator to configure all Unified CCMP and third party servers and components within a Unified CCMP deployment. The tool also provides functionality for creating connections between these components and specifying the credentials that should be used for these connections. The network topology created using this tool provides individual system components with information about how to route data within the system.
Cluster Configuration Model

The Cluster Configuration tool provides a graphical interface over a model that is used as part of the generic Unified CCMP monitoring component to test and provide connections to all services in the Unified CCMP platform.

The underlying cluster configuration model consists of the following core objects:

- **Servers**
  - A server represents a physical computer on the network.

- **Physical Resource Components**
  - A physical resource component represents a real service running on a server. For example a ConAPI service or AW Database on an ICM.

- **Physical Resource**
  - A physical resource is a grouping of physical resource components that all form part of the same system. For example a Unified CCE system may consist of an AW, and ConAPI component.

- **Logical Resources**
  - A Logical Resource is a grouping of several physical resources that represent replicated versions of a single system. For example a Unified CCE system may be dual-sided, consisting of two distinct systems for fault tolerance and redundancy. In this situation there would be a single logical Unified CCE resource with 2 physical resources instances, one representing side A and the other representing side B.

- **Physical Connections**
  - A physical connection represents a link between 2 physical resource components. The component being connected to is known as the destination component, and the component connecting is known as the source component.

- The Cluster Configuration tool supports loading and saving this model from both a Unified CCMP database and an XML file.

Equipment Mappings

Equipment mappings define mappings between folders and remote equipment which specify where imported items are placed in the Unified CCMP folder tree. They also control the visibility of remote equipment and their resources in the user interface.

Impact on Importer Behavior

The importer uses the equipment mappings to determine which folder to place new items in. The folder is chosen by applying the following logic, in order:

- If the item being imported is owned by a Remote Tenant and there is a corresponding equipment mapping for that remote tenant, the importer chooses the folder defined by the mapping.
• If the item being imported is owned by a Remote Tenant but there is no corresponding equipment mapping for that remote tenant, the importer chooses the default import location folder, if one is defined.

• Finally if there is no remote tenant mapping or default import location mapping specified, the importer chooses the /Unallocated folder within a subfolder folder named after the equipment, for example, /Unallocated/CICM123.

If an equipment mapping is changed after an initial import, the importer moves existing items to a new folder based on the logic above in the following scenarios:

• If an item is currently in the equipment’s Unallocated folder.

• If an item’s location is no longer synchronized with its Remote Tenant ownership. See the Importing Remote Ownership Changes section below for details.

Impact on User Interface

Using a combination of a user’s security permissions and the equipment mappings, it can be determined which remote equipment the user has the right to access. This is applied when the equipment is listed in the Unified CCMP web application for example, on the Person dimension edit screen and phone creation screen (Unified CM drop-down list).

The user has the right to view equipment if there is an Equipment Mapping to any tenant that contains any folder that the user has permission to view. For example, if there was a tenant: /t1 and the user had the right to see folder /t1/folder1 and there was an equipment mapping to /t1/folder2 then the user has right to view the equipment. The user also has the right to view equipment which only has equipment mappings to folders outside of tenants.

For more information on moving resources through the Unified CCMP web application please refer to the User Guide for Cisco Unified Contact Center Management Portal.

Resource Ownership Principles

Resources in Unified CCMP are owned by Tenants. This section describes how this ownership is managed and the implications of item ownership on the importer and reports.

Unified CCMP Tenant Ownership

Unified CCMP Tenants contain the items which they own and moving an item to another tenant its owner has changed. Items located outside of tenant are not owned and depending on security settings can be shared between tenants or hidden.

Remote Tenant Ownership

Some types of item originating from Unified CCE also have an additional level of ownership on the Unified CCE Instance. Unified CCE has an equivalent of a tenant
called “Customer Definitions” which can be associated with the following types of item:

- Dialed Number
- Call Type
- Label
- Network VRU Script
- Scheduled Target
- Routing Script

These items are therefore capable of being owned by a Unified CCMP tenant and a remote “tenant”.

**Remote Tenant Mappings**

Unified CCMP automatically manages which items belong to which Remote Tenant according to where they are located in the folder tree. This is made possible by mapping Remote Tenants to folders in the Cluster Configuration tool under the “Equipment Mappings” section. An item which is located anywhere under a Remote Tenant mapped folder will be associated to and owned by that Remote Tenant.

The Remote Tenant Mappings control two Unified CCMP behaviors:

- The folder that Remote Tenant owned items are placed in by the importer.
- How the Remote Tenant ownership changes when a Remote Tenant owned item is moved through Unified CCMP.

**Changing the Ownership of an Item**

An item’s ownership can be changed in three ways:

- Move the item or the folder containing the item to a different Unified CCMP tenant.
- Move an item capable of being owned by a Remote Tenant to a folder located under a different Remote Tenant Mapping.
- Change the Remote Tenant Mapping of an item on the Remote Equipment (for example, Unified CCE).

**Changing Ownership by Moving Items**

Since the ownership of items is governed by where it is located in the folder tree, moving an item can result in a change of Remote or Unified CCMP Tenant ownership.

When Remote Tenant owned items are moved through Unified CCMP, their Remote Tenant ownership is calculated by retrieving the closest Remote Tenant mapping by looking up the folder tree. If the closest Remote Tenant Mapping has changed as a
result of a move, the Remote Tenant ownership is updated and provisioned to the remote equipment.

A change of Remote Tenant mapping during a move is not allowed if the item is referenced by a customer specific Unified CCE routing script or has a membership to any other items which also have a Remote Tenant mapping. For example, the user can’t move a label out of a folder which has a Remote Tenant mapping if it is referenced by a script which has a Remote Tenant association. To move the label, it must first be removed from the script or alternatively the script should be made visible to all customers using the Unified CCE’s Script Editor.

Provisioning of Scheduled Targets is not supported, so any move which requires a change of Remote Tenant will not be allowed. Likewise if a Routing Script move results in a change of Remote Tenant ownership and Script Provisioning is disabled on for the Unified CCE in Cluster Configuration, the move operation will be aborted.

Items owned by Remote Tenants for which there are no Remote Tenant Mappings will not have their Remote Ownership changed unless they are moved into a folder with a different Remote Tenant Mapping.

Importing Remote Ownership Changes

The Data Import Service ensures that any Remote Tenant owned items are correctly located in the folder tree according to the configured Remote Tenant Mappings. If a Remote Tenant owned item has no corresponding Remote Tenant Mapping, it will be placed in the default import location. If the remote tenant of an item is changed on the Unified CCE the importer will move the item according to the defined Remote Tenant Mappings so that the item’s folder location continues to reflect the correct Remote Tenant ownership.

Using the Cluster Configuration Tool

Cluster Configuration Actions

The ICE Cluster Configuration tool supports the following ICE actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Save</td>
<td>Save any changes to the currently loaded configuration.</td>
</tr>
<tr>
<td>⬅️</td>
<td>Undo</td>
<td>Undo the last change made to the configuration.</td>
</tr>
<tr>
<td>⬅️</td>
<td>Redo</td>
<td>Redo the last change made to the configuration.</td>
</tr>
</tbody>
</table>

The ICE Cluster Configuration tool also has the following additional actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
Cluster Configuration Preferences

The ICE Cluster Configuration tool has the following additional preferences:

<table>
<thead>
<tr>
<th>Preference Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General: Advanced Mode</td>
<td>Indicates if the current user should be shown advanced properties on the cluster configuration objects within the user interface. This option is not required for day-to-day operations.</td>
</tr>
</tbody>
</table>
Chapter 4: Integrated Configuration Management

Cluster Configuration

<table>
<thead>
<tr>
<th>Preference Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General: Connection Monitor Refresh Period</td>
<td>Indicates the rate in seconds at which the connection monitoring system will check the backing store for connection state changes. Default is 5 seconds.</td>
</tr>
</tbody>
</table>

The preferences configuration pane is shown in Figure 4-6 below.

**Figure 4-6 Cluster Configuration General Preferences User Interface**

Cluster Configuration Filters

Some of the Cluster Configuration pages support a filter function to limit the number of items shown according to a user-specified filter. To access the filter, where available, click on the Show Filter icon ( ).

The actual filters that you can specify depend on the Cluster Configuration page. Within the filter area, click the Clear Filter icon ( ) to clear any filters you have specified and click on the Hide Filter icon ( ) to hide the filter options.

The following Cluster Configuration pages support a filter:

- Servers page
- Connections page
- Resources page
Cluster Configuration User Interface

When you run the Cluster Configuration tool for the first time you are automatically connected to a model using the shared Unified CCMP relational database connection. If the Cluster Configuration tool is the first ICE tool to be run then you are prompted for credentials to connect to the Unified CCMP relational database.

Once connected, you will see the initial screen shown in Figure 4-7.

Figure 4-7 Cluster Configuration Initial Interface

On the left hand side of the main interface there is a navigation menu that allows easy switching between the various configuration pages within the tool. These configuration pages include:

- Setup
  - The Setup page provides access to high-level wizards that are designed to make day-to-day configuration changes quick and easy.

- Servers
  - The Servers page allows physical servers within the model to be added, removed or updated.

- Resources
  - The Resources page provides direct access to the logical resources, physical resources, and physical resource components configured within the model. These items can be added, removed, or updated here.
• Equipment Mapping
  • The Equipment Mapping page is only enabled when connected to a Unified CCMP database. It allows you to create tenants and folders within the Unified CCMP security tree and to map equipment (for example, Unified CCE systems) to these folders for import and provisioning purposes.

• Connections
  • The Connections page allows you to view and edit the Unified CCMP component connections.

Cluster Configuration Error List Pane
The Cluster Configuration has an additional output pane, the Error List pane (see Figure 4-8). Click on the Error List tab to view the errors and warnings from Cluster Configuration tool.

Initially, this pane shows the connection errors and warnings (if any) and validation errors and warnings (if any) that were detected at startup.

Click Save or Validate to update the contents of the Error List pane with the current validation errors and warnings.

When you click Save or Validate, any connection errors and warnings are cleared from the Error List pane. You can view connection problems at any time on the Connections page.

You can click on the buttons at the top of the error pane to choose the type of error you want view. In the example in Figure 4-8, errors and warnings have been selected for display, but messages have not been selected for display.

You can click on the error details to see more information about the error.
Figure 4-8 The Cluster Configuration Error List Pane

Setup Page

For information about the Setup page in the Cluster Configuration tool, see the *Unified CCMP Installation and Configuration Manual*, Unified CCMP Component Configuration chapter, Configuring the Unified CCMP Clusters section, Server Setup subsection.

Servers Page

The Servers page within the Cluster Configuration tool allows physical servers within the Unified CCMP deployment to be added, removed or updated.

The Servers page is shown in Figure 4-9.
The Servers page consists of a left and right pane. The left hand pane contains a list view displaying all of the servers configured in the open model. The right hand pane is a property grid that displays the details of the currently selected server within the list view.

Server objects support the following basic properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Address</td>
<td></td>
<td>The default address that will be used when services within the Unified CCMP deployment connect to this server. This may be a host name or IP address.</td>
</tr>
<tr>
<td>Display Name</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc.</td>
</tr>
</tbody>
</table>
Chapter 4: Integrated Configuration Management

Cluster Configuration

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enabled</strong></td>
<td>Indicates if this server is enabled. This is a calculated field and actually indicates whether all physical resource components on this server are enabled. Changing this value will update the enabled flag of all physical resource components on this server.</td>
</tr>
<tr>
<td><strong>Id</strong></td>
<td>A unique ID used to represent this object on the backing store.</td>
</tr>
<tr>
<td><strong>Server Name</strong></td>
<td>The machine name for this server. This is used to identify a Unified CCMP service’s machine within the cluster model and should match the value returned by SQL server using @@SERVENAME or SYSTEMPROPERTY('MachineName'). Viewing Computer properties on a Windows based computer and looking at the “Computer Name” property can typically find the correct value.</td>
</tr>
<tr>
<td><strong>System</strong></td>
<td>Indicates if the Unified CCMP system installers created this object.</td>
</tr>
</tbody>
</table>

Servers may be added to the model by clicking the “Add New…” icon within the list view. Clicking this will automatically create a new server in the model and select it in the user interface ready for editing.

Right click within the Servers page to see a shortcut menu with the following functions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍀</td>
<td>Add Server</td>
<td>Add a new server to the model.</td>
</tr>
<tr>
<td>✗</td>
<td>Remove Server</td>
<td>Remove the selected server from the model.</td>
</tr>
<tr>
<td>🌐</td>
<td>View</td>
<td>Change the display style of the list view.</td>
</tr>
</tbody>
</table>

The Servers page includes a filter which allows you to filter by server name or address. Click on the Show Filter icon (🔍) to expand the filter area if it is not currently shown.

**Resources Page**

The Resources page within the Cluster Configuration tool allows logical resources, physical resources, and physical resource components within the model to be added, removed or edited.
The Resources page is shown in Figure 4-10.

Figure 4-10 Cluster Configuration Resources Page

The Resources page consists of a left and right pane, very similar to the layout of the Servers page. The left hand pane contains a list view displaying all of the logical and physical resources configured in the open model. The right hand pane is a property grid that displays the details of the currently selected object within the list view.

The Resources page includes a filter which allows you to filter by resource group type, resource type, server or resource name. Click on the Show Filter icon to expand the filter area if it is not currently shown.

The list view on the Resource page contains multiple groups. Each group represents an individual logical resource within the model. Within each group there will be one or more items, each representing a physical resource within that logical resource. This structure is highlighted in Figure 4-11.
Figure 4-11 Example Logical Resource List View Group

Logical Resources

You can select an logical resource by clicking on the group header text (for example, the text: **Provisioning Server [Provisioning Service]** (2) in the example of Figure 4-11). Selecting a logical resource displays its properties in the property grid pane, as shown in Figure 4-12.

Figure 4-12 Property Grid View for Logical Resource

<table>
<thead>
<tr>
<th>General</th>
<th>Specific</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Resources</td>
<td>0 Items</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Enabled</td>
<td>True</td>
</tr>
<tr>
<td>Name</td>
<td>Provisioning Server</td>
</tr>
<tr>
<td>Parent Resources</td>
<td>0 Items</td>
</tr>
</tbody>
</table>

The property grid for a logical resource has two tabbed sections; General and Specific. The General tab contains properties that are common to all logical resources. The Specific tab contains properties that relate to the specific type of logical resource that has been selected.

Properties of Logical Resources

All logical resource objects support the following basic properties (through the General tab):

- **Child Resources**: The logical resources in the system that may be considered to be children of this resource. For example the CICM in a...
### Cluster Configuration

**Property Name** | **Advanced** | **Description**
--- | --- | ---
Child Resources | | The logical resources in the system that may be considered to be children of this resource.
Description | | A short description for the logical resource.
Display Name | ✓ | A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)
Enabled | | Indicates if this logical resource is enabled. This is a calculated field and actually indicates whether all physical resources in this logical resource are enabled. Changing this value will update the enabled flag of all physical resources in this logical resource.
Id | ✓ | A unique ID used to represent this object on the backing store. (Read-only)
Name | | A unique name for this logical resource.
Parent Resources | | The logical resources in the system that may be considered to be parents of this resource.
Provisionable | ✓ | Indicates if provisioning has been enabled for this logical resource.
System | ✓ | Indicates if the Unified CCMP system installers created this object. (Read-only)
Version | ✓ | The source system version for this logical resource.

The derived logical resource properties for the standard built in resource types are as follows:

**Cisco CICM**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory Path</td>
<td></td>
<td>The active directory location from which users can be selected to provide supervisors with WebView login credentials. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Property Name</td>
<td>Advanced</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deployment Type</td>
<td></td>
<td>The deployment type for this CICM.</td>
</tr>
<tr>
<td>Domain Password</td>
<td></td>
<td>The password to use when connecting to active directory if &quot;Secure Authentication&quot; has been specified. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Domain User Name</td>
<td></td>
<td>The user to impersonate when connecting to active directory if &quot;Secure Authentication&quot; has been specified. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Last Dimension Import Config Change Date</td>
<td>✓</td>
<td>The value of the ControllerConfigChangeTime field in the AWControl table on the AW the last time a dimension import ran for this resource. (Read-only)</td>
</tr>
<tr>
<td>Last Member Import Config Change Date</td>
<td>✓</td>
<td>The value of the ControllerConfigChangeTime field in the AWControl table on the AW the last time a member import ran for this resource. (Read-only)</td>
</tr>
<tr>
<td>Multi Media Enabled</td>
<td></td>
<td>Indicates if multimedia reskilling is supported for this CICM. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Person Minimum Password Length</td>
<td></td>
<td>The minimum password length configured for this ICM. (Read-only)</td>
</tr>
<tr>
<td>Primary Domain Server</td>
<td></td>
<td>Primary domain server for active directory access. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Purge Items on Delete</td>
<td></td>
<td>Indicates if items should be automatically purged on delete (or only marked for delete) on ICM. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Script Lock User Name</td>
<td></td>
<td>User name for use when locking routing scripts for edit. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Script Provisioning Enabled</td>
<td></td>
<td>Indicates if script provisioning is enabled for this ConAPI resource. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Property Name</td>
<td>Advanced</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secondary Domain Server</td>
<td></td>
<td>Secondary domain server for active directory access. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Secure Authentication</td>
<td></td>
<td>Indicates whether a specific user should be impersonated when contacting to active directory. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Time Zone</td>
<td></td>
<td>The timezone for the ICM.</td>
</tr>
<tr>
<td>Time Zone Display Name</td>
<td></td>
<td>Display name for the ICM timezone. (Read-only)</td>
</tr>
</tbody>
</table>

### Data Import Server Service

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Cycle Delay</td>
<td>✓</td>
<td>The minimum delay between import cycles (in minutes).</td>
</tr>
</tbody>
</table>

### Physical Resources

You can select an individual physical resource by clicking on physical resource in the list view (for example, the text: **Provisioning Server 2** in the example of Figure 4-11). Selecting a physical resource displays its properties in the right hand property grid pane, as shown in Figure 4-13.
Figure 4-13 Property Grid View for Physical Resource

<table>
<thead>
<tr>
<th>General</th>
<th>Specific</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>True</td>
<td></td>
</tr>
<tr>
<td>Is Publisher</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Provisioning Server 2</td>
<td></td>
</tr>
</tbody>
</table>

The property grid for a physical resource is broken into three tabbed sections; General, Specific, and Components. The General tab contains properties that are common to all physical resources. The Specific tab contains properties that relate to the specific type of physical resource that has been selected. The Components tab displays details for each of the physical resource components associated with the currently selected physical resource. For example, when viewing a CICM resource, the Components tab may contain entries for the AW and ConAPI components.

Properties of Physical Resource Objects

Physical resource objects support the following basic properties (through the General tab):

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Indicates if this physical resource is enabled. This is a calculated field and actually indicates whether all physical resource components in this physical resource are enabled. Changing this value will update the enabled flag of all physical resource components in this physical resource.</td>
</tr>
</tbody>
</table>
Cluster Configuration

## Property Name | Advanced | Description
--- | --- | ---
Id | ✓ | A unique ID used to represent this object on the backing store. (Read-only)
Is Publisher | | Indicates if this physical resource is considered a publisher for replication within the logical resource.
Name | | A unique name for this physical resource.
System | ✓ | Indicates if the Unified CCMP system installers created this object. (Read-only)

Derived, resource type specific properties are exposed through the Specific tab of the property grid. The derived physical resource properties for the standard built in resource types are as follows:

### Application Server Service

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
</table>
| Notification Enabled | | Indicates if this application server is responsible for raising resource notification events.

### Data Import Server Service

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
</table>
| Last Import End | ✓ | The time when the last dimension import cycle ended. (Read-only)
| Last Import Exception Count | ✓ | The number of errors that occurred on the last import cycle. (Read-only)
| Last Import Start | ✓ | The time when the last dimension import cycle started. (Read-only)
| Last Import Type | ✓ | The type of the last import cycle. (Read-only)

### Relational Database

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
</table>
| Prefix Management Enabled | | Indicates if this database server is responsible for running the prefix management scheduled job.
The Components tab on the property grid displays the properties for all physical resource components that belong to the selected physical resource. The Components tab page is shown in Figure 4-14. This example is for a Cisco CICM physical resource with an AWS and ConAPI component. The individual components can be expanded to reveal their specific properties. In this example, the AWS component has been expanded.

**Figure 4-14   Example Property Grid View for Physical Resource Components**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purge Enabled</td>
<td></td>
<td>Indicates if this database server is responsible for running the purge scheduled job.</td>
</tr>
<tr>
<td>Scheduling Enabled</td>
<td></td>
<td>Unused.</td>
</tr>
</tbody>
</table>

The following table lists the component types supported and required for each of the built-in physical resource types:
<table>
<thead>
<tr>
<th>Physical Resource Type</th>
<th>Component Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Cisco Call Manager</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Cisco CICM AWS</td>
<td>AWS</td>
<td>✓</td>
<td>The Admin Workstation component. Used for dimension/member import.</td>
</tr>
<tr>
<td></td>
<td>ConAPI</td>
<td></td>
<td>The Cisco ConAPI server. Used for provisioning changes to CCE.</td>
</tr>
<tr>
<td>Cisco CVP Call Server</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Data Import Server Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Partitioning Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Provisioning Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Relational Database</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

### Properties of Physical Resource Components

All physical resource components support the following properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>✓</td>
<td>Application name used for this component when it is the source of a SQL connection. Can be used to identifier this resource in a SQL profile. (Read-only)</td>
</tr>
<tr>
<td>Display Name</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)</td>
</tr>
</tbody>
</table>
### Cluster Configuration

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>✓</td>
<td>A unique ID used to represent this object on the backing store. (Read-only)</td>
</tr>
<tr>
<td>Inbound Connections</td>
<td></td>
<td>All connections to this component from other systems.</td>
</tr>
<tr>
<td>Outbound Connections</td>
<td></td>
<td>All connections from this component to other systems.</td>
</tr>
<tr>
<td>Server</td>
<td></td>
<td>The server on which this component resides.</td>
</tr>
<tr>
<td>System</td>
<td></td>
<td>Indicates if the Unified CCMP system installers created this object. (Read-only).</td>
</tr>
</tbody>
</table>

In addition, the following derived properties are supported:

**Cisco CICM: AWS**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td></td>
<td>The database catalog name.</td>
</tr>
<tr>
<td>Custom Connection Test</td>
<td>✓</td>
<td>SQL query containing custom connection test logic for this component. The query should return a single row with a BIT column indicating the state of the component.</td>
</tr>
</tbody>
</table>

**Provisioning Service: Default**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Java Virtual Machine Options</td>
<td></td>
<td>All additional options that should be passed to the hosted Java Virtual Machine. The -Xrs option will be automatically passed in and does not need to be specified here.</td>
</tr>
<tr>
<td>Java Debug Port Number</td>
<td></td>
<td>The port number to use for connecting the remote debugger when Java debugging is enabled.</td>
</tr>
<tr>
<td>Java Debugging Enabled</td>
<td></td>
<td>Enable or disable debugging support in the hosted Java Virtual Machine.</td>
</tr>
</tbody>
</table>
Java RMI Server Hostname

The value of this property represents the host name string that should be associated with remote stubs for locally created remote objects, in order to allow clients to invoke methods on the remote object.

Relational Database: Default

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td></td>
<td>The database catalog name.</td>
</tr>
<tr>
<td>Custom Connection Test</td>
<td>✓</td>
<td>SQL query containing custom connection test logic for this component. The query should return a single row with a BIT column indicating the state of the component.</td>
</tr>
</tbody>
</table>

Logical resources, physical resources and physical resource components may be added/removed from the model via a context menu that can be accessed by right-clicking on the main list view area.

Diagnostic Portal Support

The ICE Cluster Configuration tool allows you to access the diagnostic portal and view diagnostic logs for the Unified CVP, Unified CCE and CCMP servers.

To view the logs for a server:
- configure the diagnostic portal for the server (you only need to do this once)
- select the required log and logging period to access the required logs.

Configuring the Diagnostic Portal

To configure the diagnostic portal for a server:

1. On the server you want to configure, identify a username and password for an authorized user of the Diagnostic Framework. This user must be a trusted domain user in the CONFIG domain security group of the server being configured.
2. In the ICE Cluster Configuration tool, select the Resources tab.
3. Click on the server that you want to configure the diagnostic portal for.
4. In the right hand pane, select the Components tab.
5. Set the Diagnostic Portal User Name and Diagnostic Portal Password fields to the username and password of the authorized user you identified above.
6. Select File >Save or click the Save icon in the toolbar.

Accessing the Diagnostic Logs

To access a diagnostic log:

1. Right click on the server instance and from the context menu, select Components, then the component, then one of:
   • View Logs to view the logs
   • View Trace Logs to view the trace logs.
2. The Diagnostic Logs window is shown. In the Diagnostic Logs window, select the type of log you want to view from the drop down list in the top left of the window.
3. Specify the From Date and To Date to filter the results by a date range, then click Fetch Result to get a list of all available logs of that type within the selected date range.
4. The bottom left pane may show the logs that match the filter, or may show servers or folders containing logs that match the filter. Double click on the server or folder to view the contents of that item and drill down to the log files. When you locate the log file you want to view, double click on the log file to view the contents in the Raw Data tab of the right hand pane. For CSV log files, you can also select the CSV tab of the right hand pane to view the log file in CSV format.

To view diagnostic logs, you must previously have configured the diagnostic portal for this server as described above.

Cluster Configuration Connection Support

Connections can be created between two physical resource components within the cluster configuration model. Components may support inbound connections (that is other components may connect to them), outbound connections (that is, they can connect to other components) or both inbound and outbound connections. Each physical resource component type has a connection type associated with it that defines how other components should connect with it.

The Unified CCMP system supports the following connection types:

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco ConAPI</td>
<td>Provides support for connections to a Cisco CMS JServer using the ConAPI Java RMI layer.</td>
</tr>
</tbody>
</table>
### Connection Type | Description
--- | ---
Microsoft SQL Server | Provides support for connections to a Microsoft SQL Server database.

Connections can be added, removed or updated by clicking on the “Inbound Connections” or “Outbound Connections” property on a component entry in the property grid. To edit connections from the selected component to other components use the “Outbound Connections” property. To edit connections to the selected component from other components use the “Inbound Connections” property. These properties are only visible on components where connections are supported.

For example, to edit outbound connections for a provisioning server:

1. In the list view, select the required provisioning server.
2. In the property grid pane, click on the Components tab.
3. Click on the Outbound Connections property (see Figure 4-15).

**Figure 4-15 Example Connection Editing**

4. Click on the ellipsis beside the Outbound Connections property. This displays the Manage Outbound Connections From dialog box, as shown in Figure 4-16.
The Manage Outbound Connections dialog box has two main panes. The left hand pane contains a tree view showing all the components that are available to connect to or from. The tree view groups all the available components by physical component type and logical resource. An example of this is shown in Figure 4-17.
Figure 4-17 Connection Edit Dialog Tree View

When a connection exists to a component instance, the icon on the component is highlighted in green. When no connection exists, the icon is greyed out.

Within each logical resource grouping, the component instances in the logical resource are listed in order of cost. The cost of a connection is an indication of the resources it has available to it and how well it will perform – connections with a lower cost can be expected to perform better than connections with a higher cost. For example, it may be more efficient to make a connection to a server that is co-located with the server requesting the connection than to make a connection to a server in another country. In this case, you would define the local server as having a lower cost than the server in another country.

Unified CCMP will use the lower cost connection if it is available. For example, if a Provisioning server was connected to a dual sided database then one of the two sides would be the preferred (lowest cost) connection and the other would be the redundant (highest cost) connection.

To change the relative cost of connections, select a component in the tree view and click the up or down arrow at the bottom right of the pane to reduce or increase the cost, as shown in Figure 4-18.
Figure 4-18  Changing the Relative Cost of Connections

When a component is selected in the tree view, the right hand pane will automatically populate with the details for the connection. The connection details pane is broken into three sections; a common header, a connection type specific properties page and a generic footer. An example for a SQL connection is shown in Figure 4-19.
The common header consists of the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected</td>
<td>Indicates if a connection exists to the selected component. Checking this box creates a connection. Unchecking this box deletes the connection.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates if this connection is enabled. Disabled connections will not be used by the Unified CCMP monitoring service.</td>
</tr>
<tr>
<td>Override Default Server</td>
<td>By default, the host name for the server on which component resides will be selected from the server objects Default Address property. However, there may be situations where the actual host name used for a specific connection between two components needs to be altered (for example when using network address translation). In these situations, the host name can be set by checking the Override Default Server box and entering the new host name in the Address field.</td>
</tr>
</tbody>
</table>
The middle pane contains connection type specific properties. For example, when editing a SQL connection this pane contains settings for the authentication mode and database catalog etc.

The common footer contains a single “Test” button. Clicking this button will test the connection using the details provided in the details section.

Connections are tested within the context of the ICE application so tests may provide inaccurate results. When the connections are utilized by the Unified CCMP system they will be created on remote servers and subject to any firewalls, network address translation or environment issues that may exist on those servers. The connections will also be established using the windows credentials of the service rather than the credentials being used to run the ICE application.

**Equipment Mappings Page**

The Equipment Mapping tab of the ICE Cluster Configuration tool allows you to create Unified CCMP tenants and folders, and to specify the way that resources on the contact center are mapped to Unified CCMP.

The Equipment Mappings page is divided into three vertical sections.

- Folder Tree section
- Source Equipment section (shown when an item is selected in the folder tree)
- Association Options section (shown when an item is ticked and highlighted in the source equipment section).

To configure your equipment mapping, in the Cluster Configuration tool, select **Equipment Mapping** in the left hand navigation pane.

**Folder Tree Section**

This section allows you to create new tenants and folders in the Unified CCMP Folder Structure. To create a new tenant or a folder, right click on the location in the tree where you would like to create the item and select **Add Tenant** or **Add Folder**.

Tenants can only be created under the root folder. Folders can be created anywhere in the tree. A Tenant is a special folder that maintains ownership of an item. For example, in a hosted environment, the host’s customers map directly to individual tenants, each of which is assigned their own individual resources, for example, Agents, Teams, Call Types etc.

Right clicking and selecting the **Refresh** option will refresh the folder structure from the database, reflecting any changes that may have been made through the Unified CCMP web application.
Source Equipment Section
This section lists all the configured source equipment. If none are configured then this list will be empty and you will not be able to do any associations.

When you select one of the items of configured equipment in the list, you will see options to map the resources belonging to that equipment to the selected folder in the Association Options Section.

Association Options Section
This section offers a list of association options between the folder or tenant in the folder tree and the source equipment.

- **Default Import Location.** Select this option to force the import to place all resources in the remote equipment into this folder or tenant.

- **Remote Tenant Mapping.** This option allows you to selectively associate resources based on remote ownership settings. Check an option to enable the drop-down list where the remote owner can be selected. After configuring a remote owner, all items owned by that owner on the remote equipment are imported to the selected folder or tenant.

The Remote Tenant Mapping is currently only valid for Cisco Unified CCE Resources. The list is populated with all the customer definitions available on the selected Cisco Unified CCE resource.

When you have completed your changes to equipment mappings, click the Save icon in the toolbar to save your changes.

Connections Page
The Connections page within the Cluster Configuration tool allows all configured connections in the system to be edited and monitored.

The Connections page is shown in Figure 4-20.
Figure 4-20 Cluster Configuration Connections Page

The Connections page consists of a resizable top and bottom pane. The top pane is the connection status monitor and shows the status of all the connections configured in the open model. The bottom pane displays the details for the currently selected connection in the list view. The bottom pane is similar to the one in Figure 4-19.

Each row in the connection status monitor consists of the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>An icon representing the status of the connection. The following options exist:</td>
</tr>
<tr>
<td></td>
<td>- Available</td>
</tr>
<tr>
<td></td>
<td>- Unavailable</td>
</tr>
<tr>
<td></td>
<td>- Disabled</td>
</tr>
</tbody>
</table>
### Cluster Configuration

#### Administration Guide for Cisco Unified Contact Center Management Portal

**Chapter 4: Integrated Configuration Management**

#### Cluster Configuration

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Server</td>
<td>The name of the physical server that this connection is being established from.</td>
</tr>
<tr>
<td>Source Component Type</td>
<td>The display name for the physical resource component type that this connection is being established from.</td>
</tr>
<tr>
<td>Destination Server</td>
<td>The name of the physical server that this connection is being established to.</td>
</tr>
<tr>
<td>Destination Component Type</td>
<td>The display name for the physical resource component type that this connection is being established to.</td>
</tr>
</tbody>
</table>

Clicking the column headers in the connection status grid will sort the view by the selected column. Click on an entry in the grid (a source or destination server, or a source or destination component type) to go to the details for that item.

The row headers on the connection status grid may optionally show an alert icon if there is a potential problem with the connection. Hovering over the alert icon will display a tool tip explaining the reason for the alert. The most common cause of an alert being displayed is to indicate that the connection status has not been updated for more than 5 minutes. This usually indicates that the source service is not running or is failing to connect with the Unified CCMP database. The source service log files should be used to investigate the cause of the problem.

To show the server details for a particular connection, hold down `Ctrl` and click on the connection.

To maximize the status monitor and show the Details and History tabs, click on the expand icon on the splitter bar (see Figure 4-21).
Replication Manager

What the Tool Provides

The Unified CCMP Replication Manager is an ICE tool that allows the administrator to manage SQL Server Replication between Unified CCMP databases.

The Replication Manager has two modes:

- Setup: Used to configure and disable SQL Server replication between the Unified CCMP databases.
- Monitor: Used to monitor general health of configured replication, at to start and stop replication agents.

The Replication Manager should typically be run on the Unified CCMP database publisher (side A) server. The user running the tool must be a Windows administrator on all the servers that take part in replication.
To use the Replication Manager, the Unified CCMP databases must be configured as dual sided.

**Using the Tool**

To start the Replication Manager tool:

1. From the Start menu, select *All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment*.
2. Enter the database information for the primary database server and click **OK**.
3. In the **Tools** drop-down, select **Replication Management**. The Replication Manager tool is displayed:
   - If SQL Server replication is not currently configured, the Replication Manager tool starts in the **Setup** tab (see section Setup).
   - If SQL Server replication is configured, the Replication Manager tool starts in the **Monitor** tab (see section Monitor).

**Setup**

The Setup tab allows you to configure or disable SQL Server Replication. It shows the configured Unified CCMP database publisher and subscriber. In addition, it shows the Distributor server properties.

The configuration that is presented is based on the cluster configuration model made using the Cluster Configuration tool. If any of the presented defaults are modified, the configuration must be saved for replication setup to continue.

**Unified CCMP Database Server Properties**

This section shows the configured Unified CCMP database publisher and subscriber servers.

- The Server Names are fixed and cannot be changed.
- The Catalog Names default to those configured in the cluster model. They may be modified. If they are modified then the modified database catalogs must exist on the respective servers.

**Distributor Properties**

This section shows the distributor properties. The distributor properties are stored in the cluster model but are not visible for update in the Cluster Configuration tool. The distributor settings can be only modified using Replication Manager. On a brand new installation, when the Replication Manager is first loaded, the tool updates the cluster model with the default settings for the distributor. As a result, the model must be saved in order to continue replication setup.
• **Server Name** is always configured on the Unified CCMP database subscriber server. This cannot be changed.

• **Catalog Name** defaults to `distribution_portal`. This may be changed if required. It is recommended to use the default.

• **Data Folder** is the path on the Distributor Server where the data file of the distribution database should be created. This defaults to the data folder path of the `master` database on the SQL Server the tool is connected to. This must be changed if this path does not exist on the distributor server. If the path does not exist on the distributor server then the replication setup will result in an error.

• **Log Folder** is the path on the Distributor Server where the transaction log file for the distribution database should be created. This defaults to the log folder path of the `master` database on the SQL Server the tool is connected to. This must be changed if this path does not exist on the distributor server. If the path does not exist on the distributor server then the replication setup will result in an error.

• **Distribution Share** is the location where the initial snapshot files will be generated. This is default to a share on the Distributor Server. The folder must be available for share. This folder is typically configured for share by the Unified CCMP Database Management utility during the installation of the Unified CCMP Subscriber database.

• **Override Distributor Admin Password** allows you to override the password that is auto-generated by the Replication Manager and is used when replication is set up. The auto-generated password is 14 characters long, and contains upper and lower case characters and a special character. If you want to override this password with your own password, select this check box and specify a password of your choice. You may need to do this if, for example, the auto-generated password does not comply with your password complexity policy.

This password is a one-off password used to set up replication. It is not stored and does not need to be recorded by the user.

### Configuring Replication

To configure replication, click the **Save** icon on the Replication Manager tool bar to save any pending changes. Once the cluster model has been saved the **Configure** button is enabled.

Click **Configure** to configure replication. If there are pending changes, the user is asked if they want to save those changes before configuring replication.

The Configure button is disabled if the SQL Server Replication is currently configured.
Disabling Replication

Click Disable to disable a configured replication.

The Disable button is enabled only if SQL Server Replication is currently configured.

Monitor

The Monitor tab allows you to monitor the general health of the configured replication. It can also be used to start and stop various replication agents if required.

The Monitor user interface is divided into four main panes:

- The top left pane lists the Replication Publisher servers and the publications hosted on the respective publisher.
- The top right pane shows various replication agents and subscriptions associated with publications. This pane has two tabs:
  - The Subscriptions tab shows all the subscriptions to a publication.
  - The Agents tab shows all other agents associated with a publication.
- The bottom left pane shows all the sessions for a replication agent in the last 24 hours.
- The bottom right pane shows all the activity for a particular replication agent session.

The Monitor refreshes the information about the replication status every five seconds.

How to use the Monitor

Select a publication in the top left pane. The subscriptions and replication agents associated with the selected publication are listed in the top right pane in the respective tab.

The Subscriptions tab shows all the subscriptions to the selected publication. It will help answer the following questions

- Which subscriptions are slow?
  This will show the latency of replication from publisher to the subscriber.
- Is the replication system healthy?
  The grid will show status icons for warnings and error for subscriptions that require attention.

The Agents tab displays the agents that are used by the selected publication. This tab shows the following agents:

- The Snapshot Agent is shown for all publications
• The Log Reader Agent is shown for transactional publications *Base* and *NonQueued*.

• The Queue Reader Agent is shown for transactional publication *Base* only.

You can use the Monitor tab to start and stop the Subscriptions and Replication Agents. In order to start or stop, right click on the selected subscription or agent and select **Start** or **Stop**.

You can view the session details for a Subscription or an Agent in the two bottom panes. Select the Subscription or Agent in the top right pane. The bottom left pane shows all the sessions for the selected Subscription or Agent in the last 24 hours. It shows the following details for each session:

• **Status** - the current status of the session.

• **Start Time** - when the session was started.

• **End Time** - when the session stopped. This is set only for sessions that are not currently running.

• **Duration** - the total duration for each session.

The bottom right pane shows the SQL Server Replication actions performed for a replication session. To see the actions for a replication session, select the replication session in the bottom left pane.

The status icons and their meanings are shown in Table 4-1 below.

### Table 4-1 Replication Manager Status Icons

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>![Unknown Icon]</td>
</tr>
<tr>
<td>Running</td>
<td>![Running Icon]</td>
</tr>
<tr>
<td>Completed</td>
<td>![Completed Icon]</td>
</tr>
<tr>
<td>Retry</td>
<td>![Retry Icon]</td>
</tr>
<tr>
<td>Error</td>
<td>![Error Icon]</td>
</tr>
</tbody>
</table>

**Identifying Errors**

The Monitor helps to identify replication errors that have occurred in replication. If an error has occurred in a particular subscription or an agent, the respective subscription or agents’ status icon will show up as error.

Select the subscription or agent that shows the error. Selecting the subscription or agent will show their sessions. If an error occurred during a session, the session will show an error icon. Select the session with the error to see the actions. The actions describes the nature of the error in the action message.
Other Considerations

Each time the Monitor refreshes, it requests data from the underlying replication system. These additional requests may sometimes affect the overall performance of SQL Server Replication, especially on busy systems. As a result it is recommended that the Monitor should not be left running for long periods of time.

Failover Manager

What the Tool Provides

The Unified CCMP Failover Manager is an ICE tool that allows the administrator to manually switch the Provisioning and Data Import services between two fully operational servers in a dual-sided Unified CCMP installation.

Only use the Unified CCMP Failover Manager to perform a planned manual failover, for example to perform maintenance on one of the servers. The service to be switched must be running and fully operational on both servers, and the data must have previously been synchronized between the servers. Do not use the Failover Manager to switch between servers in a disaster recovery scenario, for example if one of the servers has failed or has corrupt data.

Using the Tool

Preparing to Use the Failover Manager

Before performing a failover for a service:

- Be aware that the service will be unavailable during the failover, and that for a large database, the failover may take a significant period of time.
- Ensure that you have an up-to-date database backup.
- Ensure that you are logged in as a domain level user who has administrative rights on both servers, and also on the machine being used to run the ICE tool.
- Ensure that the firewalls on both servers and on the machine being used to run the ICE tool are configured as in the Network and Environment Configuration section of the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal.

Starting the Failover Manager Tool

To start the Failover Manager tool:

1. From the Start menu, select All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment.
2. Enter the database information for the primary database server and click OK.
3. In the **Tools** drop-down, select **Failover Management**. The Failover Manager tool is displayed, showing:
   - the Unified CCMP service types that support failover
   - the service that is currently active for each
   - where available, the currently inactive service that can be used for failover

   For each service type, the currently active service is shown as a depressed button, and identified by [**active**]. The inactive service is shown as a raised button that can be clicked to select it (see Figure 4-22).

   ![Failover Management ICE Tool](image)

   This display simply indicates the active and inactive services that have been configured in your Unified CCMP installation. It does not indicate the health of any of the services. Before performing a failover, you should make sure that both services are fully operational.

   **Performing a Failover Operation**

   To start a failover operation:
   1. In the Failover Manager tool, identify the service to be switched.
2. Identify the service to be switched, and click on the raised button of the currently inactive service to display the Manual Failover Wizard confirmation dialog box (see Figure 4-23).

3. If you want to restart the new active service when the failover completes (the default option), check the Restart services when complete check box. If you do not want to restart the new active service when the failover completes (for example, if you want to perform other maintenance at the same time), clear the check box.

Before continuing, make sure you really want to perform the failover at this time. The process may take some time to complete, and once it starts, it cannot be interrupted. During this time, neither the old active service nor the new active service will be available.

4. If you are sure you want to start the failover, click Next. The failover process may take some time to complete. The Manual Failover Wizard dialog box shows the progress and status for each step (see Figure 4-24). A green tick means that the step completed successfully and a red cross means that the step completed but there was an error which needs to be fixed before the failover can continue.

5. Once the wizard has finished, click Finished to return to the main Failover Manager screen.

6. If the failover reported an error, then when the wizard finishes, neither service will be running. The error message will help you identify and fix the problem and retry the failover, or you can restart the original active service.
Figure 4-23  Manual Failover Wizard Dialog Box

You are about to switch the Provisioning Service from COMETDB1A to COMETDB2A.

Are you sure you wish to continue?

- Restart services when complete

Figure 4-24  Failover Progress

Failover In Progress

- Attempting to stop service [X_IMPORTER] on server [SOLID]...
- Service [X_IMPORTER] on server [SOLID] stopped successfully
- Attempting to stop service [X_IMPORTER] on server [GOLD]...
- Service [X_IMPORTER] on server [GOLD] stopped successfully
- Attempting to swap Data Pipeline publisher...
- Data Pipeline publisher changed successfully.
- Waiting for publisher to replicate...
Failover Actions

Provisioning Service

The failover for the provisioning service:

- Stops the provisioning service on the server on which it is currently running.
- Migrates the active token.
- If requested, starts the provisioning service on the new active server.

Data Import Server Service

The failover for the data import server service:

- Stops the data import server service on the server on which it is currently running.
- Migrates the active token.
- If requested, starts the data import server service on the new active server.

Service Manager

What the Tool Provides

The Service Manager is an ICE tool that allows Unified CCMP services to be monitored, started, stopped or restarted from a single centralized location. The user requires access to start and stop services on each server containing Unified CCMP services to make full use of this tool.

Supported Services

The Unified CCMP services that are available to be manipulated by this tool are as follows:

- Application Search Services
- Data Import Server
- Hierarchy Management Services (unlicensed)
- Partition Table Manager
- Provisioning Server
- Resource Management Services (unlicensed)
- Scheduling Services (unlicensed)
- System Monitoring Services
- System Notification Services (unlicensed)
- System Subscription Services (unlicensed)
Using Service Manager

Starting the Service Manager Tool

To start the Service Manager tool, perform the following steps on the primary database server:

1. From the Start menu, select **All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment**
2. Enter the database information for the primary database server and click **OK**.
3. In the **Tools** drop-down, select **Service Manager**. The Service Manager tool is displayed, showing a table of Unified CCMP services including the machine name they are installed on, the service name and the current status (Running, Starting, Stopping or Stopped).

Starting Services

To start one or more Unified CCMP services, perform the following steps on the primary database server:

1. In the Service Manager tool, click anywhere on each service you want to start, to select the service. If you want to start all or most of the services, select the **All** checkbox, then, if required, click on any services you do not want to start. Select the **All** checkbox again to deselect all the services in the list.
2. Click **Start Selected**.
3. A dialog box opens, reporting the status of each service as it is started. Click **Close** when complete.

If a service is already started then no action is taken.

Stopping Services

To stop one or more Unified CCMP services, perform the following steps on the primary database server:

1. In the Service Manager tool, click anywhere on each service you want to stop. If you want to stop all or most of the services, click **Select/Deselect All**, then, if required, click on any services you do not want to stop. Click **Select/Deselect All** again to deselect all the services in the list.
2. Click **Stop Selected**.
3. A dialogue box opens, reporting the status of each service as it is stopped. Click **Close** when complete.

If a service is already stopped then no action is taken.
Restarting Services

To stop and restart one or more Unified CCMP services, perform the following steps on the primary database server:

1. In the Service Manager tool, click anywhere on each service you want to restart, to select the service. If you want to restart all or most of the services, click Select All, then, if required, click on any services you do not want to restart. Click Deselect All to deselect all the services in the list.

2. Click Restart Selected.

3. A dialog box opens, reporting the status of each service as it is stopped and restarted. Click Close when complete.

If a service is already stopped then it is just restarted.

Sorting Services

The Service Manager tool allows you to sort the Unified CCMP services by machine name, service name or current service status. To do this, perform the following steps on the primary database server:

1. In the Service Manager tool, click the column heading of the column you want to sort on. The list of services is sorted in ascending order according to the contents of that column.

2. If you want to sort the services in descending order, click the column name again. The list of services is displayed in descending order.

Filtering Services

The Service Manager tool allows you to filter the list of services by machine name, service name or service group.

Setting a Filter

1. In the Service Manager tool, select the filter or filters you require:
   - To filter by machine name, start typing the machine name or part of the machine name into the text box. The list of services is updated as you type, to show only those that contain the letters you specify.
   - To filter by service name, select the arrow beside the text box to display the list of available service names, and select the service name you want to filter by.
   - To filter by service group, select the arrow beside the text box to display the list of available service names, and select the service group you want to filter by.

2. The list of services is filtered according to the filter or filters you specified.
Clearing a Filter

To clear all the filters, select the icon beside the filter boxes (only shown if you have set some filters). To clear an individual filter do the following:

- To clear the filter for the machine name, delete the characters in the Machine Name text box.
- To clear the filter for the service name or service group, select the blank entry from the drop down list.

Refreshing the Filtered List

To refresh the list of services, but retain the current filters, click Refresh.

Reloading the List of Services

To clear all filters and reload the servers and services from the database, click Reload.

Shortcut Menu

Right click on a service to see a shortcut menu with the following options:

- Select/Deselect All
- Start All
- Stop All
- Start Selected
- Stop Selected
- Apply Filter
- Clear Filter

System Properties Manager

What the Tool Provides

The System Properties Manager tool is an ICE tool that allows the control of a variety of properties for the Unified CCMP components.

Using System Properties Manager

Starting the System Properties Manager Tool

To open the System Properties Manager tool, perform the following steps on the server where the properties need to modified.

1. From the Start menu, select All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment
2. Enter the database information for the primary database server and click **OK**.

3. In the **Tools** drop-down, select **System Properties Manager**. The System Properties Manager tool is displayed, showing the Unified CCMP properties, grouped by property type and functionality.

The following property types are available:

- Global Properties
- Local Properties
- Cache Properties
- Capacity Properties

When you first start the System Properties Manager from ICE, the display shows the global properties. To see the other properties, click in the appropriate tab in the left hand pane.

The rest of this section describes the available properties and their meanings.

Properties which have been changed from the system default values are shown in **bold** in the System Properties Manager user interface. Read-only properties are dimmed in the System Properties Manager user interface.

### System Properties

### Global Properties Tab

The Global Properties tab allows you to view and configure system wide items and items that affect multiple Unified CCMP components.

The properties are grouped as follows:

**Activity Monitor**

This group specifies configuration information for the Activity Monitor. This group contains the following properties:

**Provisioning Warn Threshold**: the number of seconds after which an item or membership in the provisioning queue is shown in the middle (orange) band of the Activity Monitor.

**Provisioning Max Threshold**: the number of seconds after which an item or membership in the provisioning queue is shown in the top (red) band of the Activity Monitor.

**Code Lookup and Supported Equipment Types**

This group specifies information about equipment types. This group contains the following property:
Code Lookup and Supported Equipment Types: The type of equipment that is used to import codes into the Unified CCMP database. Currently the only supported value is CRT_CICM (equipment type Cisco CICM)

Gadget Management
This group specifies the gadget management settings. This group contains the following properties:

Gadgets Cache Expiration Period: The time period in seconds after which a cached gadget definition expires and is removed from the gadget cache. A zero time period will disable the gadget cache.

Gadgets Cache Expiration Period: The time period in seconds after which a cached gadget definition expires and is removed from the gadget cache. A zero time period will disable the gadget cache.

Gadget File Path: The file path to a location on the web server where gadget files are located. This path is used during gadget development. The file name must match the gadget title.

Importer State
This group specifies the import data settings. This group contains the following properties:

Bow Wave Duration Hours: The time period in hours relative to a cluster resource creation date that constitutes the bow wave period. The value is between 1 and 24.

Bow Wave Effective From: The effective from date for dimensions created during a bow wave.

Last Cluster Update: (Read Only). The date and time the cluster was last updated.

Login Authentication Configuration
This group specifies the way that Unified CCMP logins are authenticated. This group contains the following properties:

Active Directory Binding Options: Specifies the way that the Unified CCMP App/Web server connects to Windows Active Directory. This property only applies if Login Authentication Mode is set to Active Directory. In most installations, the default values will be suitable, but consult your Windows system administrator if you need further advice. Each of the following options can be selected or cleared:

- Negotiate (selected by default)
- None
- Sealing
- Secure Socket Layer (selected by default)
- Server Bind
- **Signing**
- **Simple Bind** (selected by default)


**Active Directory Context Type**: Specifies the type of store used to authenticate against. This property only applies if **Login Authentication Mode** is set to **Active Directory**. In most installations, the default value will be suitable, but consult your Windows system administrator if you need further advice. The following options are available:

- **Application Directory**
- **Domain** (default)
- **Machine**


**Credential Cache Expiration Period**: Specifies the time in seconds that the user’s login is cached before being re-authenticated. This re-authentication is internal, and not visible to the user. Choose a longer cache expiry to reduce the traffic between the Unified CCMP Web/App server and the authenticating server.

**Credential Cache Expiration Type**: Specifies the way in which the expiry period for re-authentications is determined. One of:

- **Absolute Expiry**: the expiry period for re-authentication is measured from the last authentication, whether or not the user has been active on the system since that time.
- **Sliding Expiry**: the expiry period for re-authentication is measured from the last time the user was active on the system, or from the last re-authentication, if that was later.

**Ext Auto Create User**: Reserved for future use.

**Login Authentication Mode**: Specifies the way that Unified CCMP authenticates users. One of:

- **Portal**: users must log into Unified CCMP directly using a Unified CCMP username and password
- **Active Directory**: users are automatically logged into Unified CCMP using their Windows login credentials.
Login Security

This group specifies the default behavior when creating users. This group contains the following properties:

Create Advanced Users Groups: Determines if an advanced users group is created when a folder is set to not inherit permissions. One of True or False.

Create Basic Users Groups: Determines if a basic users group is created when a folder is set to not inherit permissions. One of True or False.

Create Supervisor Users Groups: Determines if a supervisor users group is created when a folder is set to not inherit permissions. One of True or False.

Default Home Folder Role: The role that is automatically associated with a user on their home folder when the home folder is created.

Default Tenant Administrators Role: The role that is automatically associated with the Administrators group when a new Tenant or policy root folder is created.

Default Tenant Supervisors Role: The role that is automatically associated with the Supervisors group when a new Tenant or policy root folder is created.

Default Tenant Users Role: Specifies the role that is automatically associated with the Users group when a new Tenant or policy root folder is created.

Home Folder Suffix: The suffix that is appended to the username when a home folder is created for a user.

Max Password Length: The maximum number of characters allowed in a password.

Min Password Length: The minimum number of characters allowed in a password.

Minimum Password Lifetime: The minimum number of days that a password can be used for, before it is possible to change it.

Password Expiry: The number of days before a password expires and has to be changed, measured from the date that the password was last changed.

Password Format: The required password format. This field can also be set in the web application using Settings > Security Settings > Password Format. If one of predefined password formats (Low Security, Medium Security, Medium/High Security or High Security) is chosen in the web application, this field is automatically populated with the corresponding expression. This field is a .NET regular expression, except that the expression \{MIN_MAX\} can also be used to specify that the password length must lie between the values specified for Min Password Length and Max Password Length. For example, if Min Password Length is 8 and Max Password Length is 20, then \{MIN_MAX\} is equivalent to \{8,20\} in the .NET regular expression syntax.

Password Hash Algorithm: Specifies the algorithm for encoding user passwords. Passwords are encoded using the hash algorithm in force when the password is created. To change the encoding of existing passwords, in the web application User
Manager tool, set **User must change password at next login** for each user. One of the following (in order of increasing security):

- **SHA1** (default)
- **SHA256**
- **SHA384**
- **SHA512**

**Password History:** The number of previous passwords that are saved and cannot be reused when a user password is changed.

**Password Reuse Time:** The minimum number of days that must elapse before a previous password can be reused.

**Product Name:** The name of the product to display in the user interface, allowing organizations to personalize the product.

**User Lockout:** The number of failed login attempts that a user is allowed before their account is locked.

**Media Upload**

This group specifies the default behavior for uploading media. This group contains the following properties:

**Media File Accepted Formats:** A comma separated list of file extensions that are valid for media files.

**Media Share:** The network share name where WAV files uploaded through the Unified CCMP user interface will be placed for replication to the CVP Media Server.

**Miscellaneous**

This group specifies some miscellaneous properties. This group contains the following properties:

**Agent Description Field Mandatory:** Whether the agent description field is mandatory when agents are created and edited. One of **True** or **False**.

**Agent Description Format:** A regular expression defining the characters that are not allowed in the agent description field. Special characters must be escaped. For example, if you wanted to exclude the characters “z”, “&” and “*”, you would enter \[z\&*\].

**Allow Folder Tree Drag Drop:** Whether the web application supports drag and drop for folders in the folder tree. One of **True** or **False**.

**Display Purge Button Stuck Seconds:** The number of seconds to wait before determining that an item in “S” or “P” state is blocked (see section Database Codes for the meaning of the state codes). Once this time has been exceeded a purge button is displayed in the Web Application.
Menu Items: Custom application can be added to the menu bar by the inclusion of a display name and URL. Items separated by a semi colon.

Prov Agent State Trace Enabled: Determines whether System Manager users can enable the ICM State Trace feature on agents. ICM State Trace provides enhanced logging information about when individual agents move from one state to another.

Query Parameter Boundary: The maximum number of parameters in an SQL query before a sub query is generated.

Supported Languages: The culture codes for the languages supported by the installation. Click the drop-down list to see and select the supported languages.

Supported Peripheral Types: The peripheral types that can be associated with resources such as agents. Click the drop-down list to see and select the supported peripheral types.

Web Server Debug Info Disclosure: Whether server and culture information is shown in the web application when the user right-clicks on the CCMP logo. One of True or False.

Other Security
This group specifies other security options. This group contains the following properties:

Enable User Copy: Determines whether the user copy feature is available in the Unified CCMP web application. One of True or False.

Inherit Permissions Default: Determines whether the Inherit Permissions check box is selected by default when a new folder is created. One of True or False.

Push Policy Changes to Child: Determines whether the check box in Security Manager that pushes any changes made down to any children policy roots is checked.

Partitioning State
This group specifies database partitioning options. This group contains the following properties:

Historical Partition Indexes Enabled: Determines whether historical partition indexes are generated. One of True or False.

Last Partition Metadata Change: The date and time that the partition metadata was last updated (read-only).

System Limits

Max Dimension Associated Items: The maximum number of associated items that can be listed for a dimension in the Web Application.

Max Dimension Drop Down List Items: The maximum number of dimension items that can be shown in a drop-down list in the Web Application before the list is disabled.
Local Properties Tab

The Local Properties tab allows you to view information from the local machine. The properties are grouped as follows:

Partitioning State

This group specifies partition table information. This group contains the following property:

**Last Partition Tables Refresh**: The date and time of the last partition table refresh (read only).

Versioning Group

This group displays the following version numbers. This group contains the following properties:

**Build Version**: The build cycle that the installation was taken from (read only).

**Schema Version**: The version of the database schema being used (read only).

Resource Properties Tab

The Resource Properties tab allows you to view and configure the way that resources are handled in Unified CCMP. The properties are grouped as follows:

Resource Items

This group lists each resource item. Each resource item has the following properties:

**ApplicationCacheEnabled**: Determines whether resources of this type are loaded into the application cache so the search engine has fast access to the resource details.

**FactCacheEnabled**: Determines whether the fact details for resources of this type are loaded into the fact cache to provide faster access for reporting features.

**ImportEnabled**: Determines whether resources of this type are imported from the Unified CCE and Unified CM servers in the deployment.

Resource Members

This group lists each resource membership. Each resource membership has the following properties:

**ApplicationCacheEnabled**: Determines whether resource memberships of this type are loaded into the application cache so the search engine has fast access to the resource membership details.

**FactCacheEnabled**: Determines whether the fact details for resource memberships of this type are loaded into the fact cache to provide faster access for reporting features.
ImportEnabled: Always False for resource memberships.

Capacity Properties Tab

The Capacity Properties tab allows you to view and configure the capacity rules for the remote equipment. A capacity rule may apply to:

- all equipment of a specified type in the cluster, or only to a specific equipment instance
- all tenants in the cluster, or only to a specific tenant.

The properties of the capacity rules are determined by the remote equipment. The properties are grouped by capacity rule. Each capacity rule has the following properties:

CapacityId: The database primary key of the capacity rule (read-only).

ItemType: The resource type that the capacity rule applies to (read-only).

MemberType: The membership that the capacity rule applies to, or <None> (read-only).

ViaMemberType: The additional membership that the capacity rule applies to, or <None> (read-only).

Description: The description of this capacity rule (read-only).

MaxCapacity: The maximum number of resources or memberships allowed under this capacity rule. This value can be edited if the System property is False, or if the ClusterInstance property is <All>. Otherwise this value is read-only.

ClusterType: The cluster type of the remote equipment that the capacity rule applies to (read-only).

ClusterInstance: The remote equipment that the capacity rule applies to (read-only). One of:

- <All>, if the capacity rule applies to all instances of that equipment type
- the specific cluster name of the remote equipment, if the capacity rule only applies to a single instance of that equipment type.

TenantName: The tenant that the capacity rule applies to (read-only). One of:

- <All>, if the capacity rule applies to all tenants on the specified equipment
- the specific tenant name, if the capacity rule only applies to a single tenant on the specified equipment.

CreationDate: The date that this capacity rule was created (read-only).

ModifiedDate: The date that this capacity rule was last modified (read-only).

System: Determines whether this the capacity rule is a default system value, or whether it was added as a customization (read-only). One of True (the rule is a default system value) or False (the rule is a customization).
**Enabled:** Determines whether this capacity rule should be considered when creating a resource or membership. One of **True** or **False**.
5. Remote Resource Provisioning

All system and security management for Unified CCMP is performed through the Unified CCMP web application. For further information on how to use the Unified CCMP web application, please see the User Guide for Cisco Unified Contact Center Management Portal. Most system and security management after the initial setup is performed by individual tenant administrators.

System Management

The System Manager tool allows the user to create and manage resources and resource folders within a hierarchical folder structure. Users with sufficient security privileges can access and manage the entire contents of the system via the System Manager interface. This lets you remotely configure and administer key aspects of your Unified CC system.

How to manage resources is explained in more detail in the System Management chapter of the User Guide for Cisco Unified Contact Center Management Portal.

Remote Resource States

A remote resource is any kind of entity on Unified CCE or Unified CM, for example: agents, teams, skill groups, and phones. All the remote resources in Unified CCMP participate in a state machine. A state machine is a collection of states which a resource will progress through during its lifetime. It is important to understand the state machine when troubleshooting problems in Unified CCMP.

The states are shown in Figure 5-1 below:
Provisioning changes are managed via periodic cycles performed by the Unified CCMP Provisioning Server. After a change has been committed, the Provisioning Server will wait a configurable period of time (five seconds by default), before moving onto the next operation. This configurable throttle reduces the possibility of overloading the remote equipment during busy times.

**State Descriptions**

As a remote resource progresses through the state machine its status is reflected as follows:
Pending Active

Pending Active is the initial state for all resource items created through Unified CCMP. Pending Active tells us that the resource exists in Unified CCMP, but has not yet been created on the remote equipment. This may be a result of the remote item being configured with an effective from data or simply mean that the change has not yet been made yet.

When a resource item is in the Pending Active state, no updates are accepted from importer microflows or user interface, with the exception that the item may be changed to the Delete Pending state. This business logic ensures that the Unified CCMP database acts as conflict master.

Ready

Ready is the normal state of a resource item in the Unified CCMP database. It indicates that the resource item has been fully provisioned on all the remote equipment controlled by Unified CCMP.

If the user interface edits a resource item then it is changed to the Pending Active state. If an importer microflow updates a resource item, then it changes to the respective state depending on the change.

Error

The Error state signals that an error has occurred while provisioning a resource item. It means that the current status of the item in Unified CCMP is not reflected on the remote equipment.

Using the System Manager user interface, additional information about the error may be sourced by viewing the history tab of the remote resource. This information will help the user identify why the remote resource could not be provisioned allowing them to update the configuration and re-save the remote resource.

The user may choose to remove the remote resource using the Unified CCMP System Manager or the Unified CCE / Unified CM tools which will then result in it progressing to deleted status.

When an item enters Error state then a Purge button will be displayed in the status tab allowing the resource to be marked as purged in the Unified CCMP database. This allows changes in Unified CCMP to be cleared, forcing the importer to re-create the item on the next cycle. This will also separate the historical data for the item at the point in time the purge is performed, linking all new historical data to the new resource that will be created by the importer.

Delete Pending

This state signals that the resource item is to be deleted from all external systems.

The DELETED flag and EFFECTIVE_TO fields on the resource item row in the TB_DIM_ITEM_PKEY_MAP table will be set in the transition to this state. User interface operations are not allowed on a resource item which is Delete Pending – editing in
particular. Once it has been changed to Delete Confirmed then the resource item can be reactivated.

The underlying delete business functions in the Unified CCMP Unified CCE and Unified CM connectors always check to see if the resource item is valid before starting a delete operation.

**Deleted**

A resource item changes to the Deleted state once it has been deleted from all externally controlled systems. The Delete Pending microflow runtime ensures all externally controlled systems are updated before the transition occurs. The workflow must also ensure any memberships are reset, for example the deletion of an agent may first require it to be removed from any agent teams.

**User Interface**

The user interface can only edit resource items which are in the Error and Ready states. Resource items in the Pending Active and Delete Pending states cannot be edited until the provisioning system has processed the resource item. There are a number of exceptions to this rule where effective dates can still be changed in the Pending Active state.

The Error state is particularly important as it catches all the resource items that could not be provisioned. The normal use of the Error state is to hold resources that need to be edited before being provisioned again (by changing them to the Pending Active state).

**Figure 5-2 Editable Resource States**

**Database Codes**

The resource state field in the `TB_DIM_ITEM_PKEY_MAP` table uses the following codes:

<table>
<thead>
<tr>
<th>Code</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Ready</td>
<td>Ready is the normal state of a resource item in the Unified CCMP database. It indicates that the resource item has been fully provisioned on all externally controlled systems.</td>
</tr>
<tr>
<td>S</td>
<td>Pending Active</td>
<td>Pending Active is the initial state for all resource items created/edited through Unified CCMP.</td>
</tr>
<tr>
<td>P</td>
<td>Delete Pending</td>
<td>The Delete Pending state signals the resource item is to be deleted from all externally controlled systems. The EFFECTIVE_TO and DELETED fields are also set in the <code>TB_DIM_ITEM</code> table.</td>
</tr>
</tbody>
</table>
Chapter 5: Remote Resource Provisioning

Remote Resource States

<table>
<thead>
<tr>
<th>Code</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Delete Confirmed</td>
<td>A resource item transitions to the Delete Confirmed state once it has been deleted from all externally controlled systems.</td>
</tr>
<tr>
<td>E</td>
<td>Error</td>
<td>The Error state signals an error occurred provisioning a resource item.</td>
</tr>
</tbody>
</table>

**Memberships**

Memberships in the Unified CCMP database also have effective dating and a status. The Pending Active workflows ensure that changes to memberships are reflected on any externally controlled system. The state of a resource item shows whether it has been provisioned on all external systems (for example, whether an agent has been added to Unified CCE). The state also reflects whether all its memberships are up to date and fully provisioned. This approach makes it easy in the user interface to show an item’s state.

**State Machine Scenarios**

The following table explores the state machine through some user case scenarios.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Expected Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension item is created and provisioned (transitioning it to the Ready state). It is then deleted from one of the externally controlled systems.</td>
<td>Dimension item is transitioned to the Delete Confirmed state in Unified CCMP.</td>
</tr>
<tr>
<td>Dimension item in the Delete Pending state is deleted from a different external system.</td>
<td>Dimension item is transitioned to the Delete Confirmed state in Unified CCMP.</td>
</tr>
<tr>
<td>Dimension item in the Delete Pending state is reactivated on an externally controlled system.</td>
<td>Dimension item is left in the Delete Pending state and will be deleted on all externally controlled systems.</td>
</tr>
<tr>
<td>Dimension item in the Delete Confirmed state is reactivated on an external system.</td>
<td>Dimension item is transitioned to the Ready state in Unified CCMP.</td>
</tr>
<tr>
<td>Dimension item fails to provision correctly; perhaps there is a network connectivity issue between Unified CCMP and the Unified CM.</td>
<td>Dimension item is transitioned to the Error state. Any systems it was correctly provisioned on are reflected in Unified CCMP database. Details of the provisioning problem are available in the audit tables.</td>
</tr>
</tbody>
</table>
### Provisioning Non-CCE Peripheral Types

By default items may only be provisioned through Unified CCMP on peripherals of client type Enterprise Agent, System PG and IPCC Enterprise Gateway. These are the supported peripheral types that Unified CCMP has been configured and tested with. It is however possible to configure Unified CCMP to provision items to peripherals that are not constrained to the types listed above.

To configure Unified CCMP to support another peripheral client type follow these steps:

1. On the primary database server navigate to **Start > All Programs > Management Portal > Integrated Configuration Environment.**
2. Enter the database credentials for the local database and click **OK.**
3. Select the **System Properties** tool from the drop-down list.
4. Locate the Supported Peripheral Types option in the Miscellaneous section and from the drop-down list, select the checkbox beside the Peripheral Types you want to be supported.

5. Click Save and close ICE.

When performing an update to the supported peripheral client types ensure that the existing types are not removed from the comma separated list as this will change standard product behavior. The standard supported types are 30,50,51.

6. Restart all Unified CCMP Application Server Services on all of the servers hosting the Application Service.

7. Perform an IISReset command on all of Unified CCMP Web Servers by navigating to Start > Run…, entering IISReset and click Return.

Unified CCE Purge Logic

When remote equipment resources are deleted in Unified CCMP then they are set to the Delete Pending state in the Unified CCMP database. This forces the Provisioning Server to remove the associated resource(s) on the related equipment.

Some resource types in Unified CCE implement purge logic, causing items to be propagated to a resource pool (similar to a recycle bin in Windows). This stops any properties that are associated with these items from being reused for new resources configured on that Unified CCE instance. For example, a Person in Unified CCE is allocated a Login Name which is a unique identity used to log the agent onto Unified CCE. If a Person is deleted in Unified CCE then it will be moved to the Deleted Objects section of the Unified CCE Configuration Manager tool. The Login Name associated with that Person cannot be re-used until the Person has been manually removed from the Deleted Objects section.

When Unified CCMP’s Unified CCE provisioning capability is configured, the user can select whether the associated CCE instance supports purge on delete logic. If purge on delete is enabled, then resources deleted through Unified CCMP are automatically removed from the Unified CCE Deleted Objects section. This allows their associated properties to be re-used immediately.

If purge on delete is not enabled then Unified CCMP reports an error if you try to reuse a property that is associated with a resource in the Unified CCE Delete Objects section of Configuration Manager. A typical error message for this scenario is:

“Login Name duplicate detected - the login name you are trying to use is currently assigned to another resource”.
Mobile Agent Support

About Mobile Agents

Unified CCE offers a feature called Unified Mobile Agent, which allows any agent with a PSTN phone and a broadband VPN connection to access contact center calls as if they were in the contact center.

This means that:

- agents have the added flexibility of working remotely
- temporary staff can be added to deal with high call volumes at peak times
- geographically dispersed agents with the required skillsets can operate as a team within the contact center environment.

A mobile agent can operate in one of two modes:

- **Call by Call**: the agent is called individually for each connected call and disconnected at the end of the call.
- **Nailed Connection**: the agent is called at logon and their connection with the contact center remains until they logoff.

For more information about Unified Mobile Agent, please refer to *Mobile Agent Guide for Cisco Unified Contact Center Enterprise & Hosted*, section “Introduction to Cisco Unified Mobile Agent for Unified CCE/Unified CCH” (link checked August 2013).

Configuring Mobile Agent Support in Unified CCE

There are several steps required to configure the system to support mobile agents. These steps must be performed in Unified CCE before mobile agents can be created. For detailed instructions see *Mobile Agent Guide for Cisco Unified Contact Center Enterprise & Hosted*, section “System Configuration for Unified Mobile Agent” (link checked August 2013).

Configuring Mobile Agents

About Configuring Mobile Agents

When you have configured the system to support mobile agents, you can configure individual agents as mobile agents. To do this, you need to:

- configure the agent desk settings (Agent Desktops in CCMP) to support mobile agents
- configure two CTI ports (IP Phones in CCMP) for each mobile agent: you need a remote CTI port to initiate the call, and a local CTI port to be the mobile agent’s virtual extension
- configure a device target for the local CTI port (in CCMP, this is automatically done via the Directory Number resource).
The agent desk settings can be configured from the CCMP Web Application. If Unified CM provisioning is enabled, the CTI ports and device target can also be configured from the CCMP Web Application or the Resource Management Web Service APIs. The instructions for performing these steps in the CCMP Web Application are below.

If Unified CM provisioning is not enabled you will need to configure the CTI ports and device targets using Unified CM or the domain manager for that equipment. For more information see Mobile Agent Guide for Cisco Unified Contact Center Enterprise & Hosted, section “System Configuration for Unified Mobile Agent” (link checked August 2013) or the Unified CM documentation.

Configuring the Agent Desk Settings for Mobile Agents

To configure the agent desk settings for mobile agents, in the CCMP Web Application:

1. Create an Agent Desktop.
2. On the Details tab for the Agent Desktop, set the Remote Agent Type field to one of Call by Call Routing, Nailed Connection Routing or Agent Chooses at Login, depending on your requirements.
3. Assign this Agent Desktop to the Agents that are to be mobile agents.

Configuring CTI Ports and Device Targets for Mobile Agents

To configure the CTI ports and device targets for a mobile agent (if Unified CM provisioning is enabled), in the CCMP Web Application:

1. Create an IP Phone for the local CTI port. The name used for the IP Phone must begin with the characters LCP. This allows Unified CCE to identify this as a local CTI port.
2. Create an IP Phone for the remote CTI port. The name used for the IP Phone must begin with the characters RCP. This allows Unified CCE to identify this as a remote CTI port.
3. Create a Directory Number and associate it with the IP Phone that corresponds to the local CTI port.
4. On the Details tab for the Directory Number associated with the local IP phone, select Contact Center Enabled. This automatically configures the device target for the local CTI port.

For more information, see Mobile Agent Guide for Cisco Unified Contact Center Enterprise & Hosted, section Unified CM CTI Port Configuration and Mapping for Unified Mobile Agent (link checked August 2013).
Partitioned Internet Script Editor

About the Partitioned Internet Script Editor

Cisco’s Internet Script Editor (ISE) can be integrated with Unified CCMP, which allows routing scripts and the resources within those routing scripts to be partitioned using Unified CCMP security. ISE users see only the scripts and the resources within those scripts that they are authorized to access, according to the Unified CCMP security model. For example, when creating a routing script element to route to a dialed number, the ISE user will only see the dialed numbers that the corresponding Unified CCMP user is authorized to access. Similarly, when viewing the available routing scripts, the ISE user will only see the scripts available to the corresponding Unified CCMP user.

ISE integration with Unified CCMP uses the Unified CCMP Analytical Data Web Service to implement the secure partitioning, and requires specific configuration settings in both Unified CCE and Unified CCMP in order to work properly.

Secure partitioning using Unified CCMP is currently only supported for the Cisco Internet Script Editor (ISE). Users of the standard Script Editor on the Unified CCE AW will still see all resources on their associated Unified CCE instance.

Configuring ISE Integration with Unified CCMP

About the Configuration Steps

To configure ISE integration with Unified CCMP, you need to:

1. Configure Unified CCE to use Unified CCMP security partitioning.
2. Create one or more linked Unified CCE and Unified CCMP users with appropriate permissions. The Unified CCE user and the Unified CCMP user are both linked to the same Windows active directory user, which must already exist on the domain on which Unified CCE and the Unified CCMP servers are located.

Configuring Internet Script Editor to use Unified CCMP Security Partitioning

To configure the Internet Script Editor to use Unified CCMP security partitioning:

1. Log in to the Unified CCE Admin Workstation.
2. In the Unified CCE Web Setup, Administration and Data Servers section, set the following values:
   - Select Internet Script Editor (ISE) server.
   - Select Authorization Server.
   - In Authorization Server Name, enter the name of the Authorization Server. This is the Unified CCMP App/Web Server that will be used to apply Unified CCMP security to partition the resource data.
Chapter 5: Remote Resource Provisioning

- In **Authorization Server Port**, enter the port on which the Unified CCMP Analytical Data Services Web Service has been hosted. By default, this is port 8087, but if this has been changed for your installation, enter the value that your installation uses.

3. Ensure that the firewall on the server running the Unified CCE AW has been configured to allow inbound traffic from ISE on the appropriate port. For more information, consult the relevant Unified CCE documentation.

4. Ensure that the specified Authorization Server port on the Unified CCMP Authorization Server has been configured in the firewall to allow inbound HTTPS traffic.

When you have completed these configuration steps, when you run ISE, you must specify a Unified CCE user that corresponds to a linked Unified CCMP user. You will not be able to log in otherwise. When you have logged in, you will see only the script items that the linked Unified CCMP user is able to see.

**Creating a Linked Unified CCE and Unified CCMP User**

There are two ways to create a linked Unified CCE and Unified CCMP user so that Unified CCMP security can be applied to ISE scripts and resources. Normally you will create the user in Unified CCMP, specify that it is ISE-enabled and Unified CCMP will automatically create the linked Unified CCE user. But if a suitable user already exists in Unified CCE, Unified CCMP will automatically import it. You then can configure the user as ISE-enabled in Unified CCMP.

**Creating a Linked User in Unified CCMP**

To create a Unified CCMP user that can be used to apply Unified CCMP security to ISE scripts and resources:

1. In Unified CCMP, select **Tools > Users** and create a Unified CCMP user with the same name as the corresponding Windows active directory user which is to be associated with the linked Unified CCMP and Unified CCE users. The Unified CCMP user name must be specified as `<username>@<domainname>`, where `<username>` is the Windows username and `<domainname>` is the fully qualified Windows domain name, for example, `iseuser1@testdomain.local`.

2. On the **Details** tab, select **Account Enabled**.

3. If your Unified CCMP installation has been configured to use SSO, you will not be asked to specify a password for this user. Otherwise, ensure that this Unified CCMP user is given the same password as the corresponding Windows active directory user.

4. Give this user **Browse Dimensions** permission to the Unified CCE folders and resources to which they require permissions. You can do this in one of the following ways:
• Select the **Groups** tab and add the user to a group that already has the required permissions.

• Alternatively, after you have finished the remaining steps in this section, select **Tools > Security**. On the **Users** tab, select the checkbox beside the user you have just created, then click **Change Permissions**. Identify a suitable folder role that includes **Browse Dimensions**, and assign it to this user for each of the folders containing the scripts and resources you want this linked user to be able to access.

5. Click **Save** to create the Unified CCMP user and a linked Unified CCE user. The Unified CCE user is created on the Unified CCE instance that is associated with the folder where the Unified CCMP user has been created.

### Configuring an Imported Unified CCE User for ISE Integration

To configure an imported Unified CCE user to apply Unified CCMP security to ISE scripts and resources:

1. In Unified CCMP, locate the imported Unified CCE user. The Unified CCMP user name will be formatted as `<username>@<domainname>`, where `<username>` is the Windows username and `<domainname>` is the fully qualified Windows domain name, for example, `iseuser1@testdomain.local`. The imported user will be in your default import location unless you have moved the user after the import.

2. Click the user to view the details.

3. On the **Details** tab, select **Account Enabled** to enable the user.

4. Give this user **Browse Dimensions** permission to the Unified CCE folders and resources to which they require permissions. You can do this in one of the following ways:
   - Select the **Groups** tab and add the user to a group that already has the required permissions.
   - Alternatively, after you have finished the remaining steps in this section, select **Tools > Security**. On the **Users** tab, select the checkbox beside the user, then click **Change Permissions**. Identify a suitable folder role that includes **Browse Dimensions**, and assign it to this user for each of the folders containing the scripts and resources you want this linked user to be able to access.

5. Click **Save** to update the user details for the linked Unified CCMP user.

6. If your Unified CCMP installation does not use single sign on, then before this user can be used to access ISE, you must log in to Unified CCMP as this user and supply a password when prompted. This password must be the same as the password for the corresponding Windows active directory user. If your Unified CCMP installation uses single sign on, this step is not required.
Supported Objects

The Script Editor can partition the following resources in a routing or administration script.

Resources that are not supported for Unified CCMP partitioning in this release of the Script Editor are shown in the table below in italics. In this release, all resources of these types will be available to the ISE user, regardless of the Unified CCMP partitioning.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Related Resources</th>
<th>Script Node(s)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Route</td>
<td>Agent Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Peripheral (for Peripheral Number)</td>
<td>Agent To Agent Node</td>
<td>Select by: Peripheral/Peripheral Number, Enterprise Name, Skill Target ID</td>
</tr>
<tr>
<td></td>
<td>Peripheral, Enterprise Skill Group, Enterprise Route, Route</td>
<td>Queue To Agent Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Agent, Route</td>
<td>Route Select Node</td>
<td>Using Agent(s) as selector</td>
</tr>
<tr>
<td>Announcement</td>
<td>N/A</td>
<td>Announcement</td>
<td></td>
</tr>
<tr>
<td>Call Type</td>
<td>N/A</td>
<td>Call Type Node</td>
<td>Two modes: Static Dynamic by Name or ID</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
<td>Requalify Call Node</td>
<td></td>
</tr>
<tr>
<td>Dialed Number</td>
<td>N/A</td>
<td>Dialed Number Node</td>
<td></td>
</tr>
<tr>
<td>Enterprise Service</td>
<td>Service, Route</td>
<td>Enterprise Service Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Service, Route</td>
<td>Route Select Node</td>
<td>Using Enterprise Service as selector</td>
</tr>
<tr>
<td>Enterprise Skill Group</td>
<td>Skill Group, Route</td>
<td>Route Select Node</td>
<td>Using Enterprise Skill Group as selector</td>
</tr>
</tbody>
</table>
## Chapter 5: Remote Resource Provisioning

### Partitioned Internet Script Editor

<table>
<thead>
<tr>
<th>Resource</th>
<th>Related Resources</th>
<th>Script Node(s)</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Routing Client</td>
<td>Label Node</td>
<td>Labels refined by Routing Client</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>N/A</td>
<td>Media Routing Domain Node</td>
<td>By default: Cisco_Voice, Email and Multisession</td>
</tr>
<tr>
<td>Precision Queue</td>
<td>N/A</td>
<td>Precision Queue</td>
<td>Dynamic not supported for this release</td>
</tr>
<tr>
<td>Service</td>
<td>Route</td>
<td>Service Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Route</td>
<td>Route Select Node</td>
<td>Using Service(s) as selector</td>
</tr>
<tr>
<td>Skill Group</td>
<td>Route</td>
<td>Skill Group Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Route</td>
<td>Queue To Skill Group Node</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Route</td>
<td>Route Select Node</td>
<td>Using Skill Group(s) as selector</td>
</tr>
<tr>
<td>VRU Script</td>
<td>N/A</td>
<td>Run External Script Node</td>
<td></td>
</tr>
</tbody>
</table>

### Troubleshooting ISE Integration with Unified CCMP

#### Error Reporting

If there are problems with the ISE integration with Unified CCMP, ISE may report an error. Some error scenarios may also result in an entry in the log file on the Unified CCMP Application Server that was specified as the Authorization Server.

#### Error when starting ISE

**Problem**

ISE takes a long time to open, then reports the following errors:

- Web server access forbidden.
- Cannot connect to distributor. Script Editor will now exit.

**Sample Log File Entry**

None.
Causes and Solutions

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The AW Distributor service is not running</td>
<td>Start the Distributor service on the AW.</td>
</tr>
<tr>
<td>The AW Distributor service is running but ISE cannot connect to it</td>
<td>Ensure that the firewall on the server running the Unified CCE AW has been configured to allow inbound traffic from ISE on the appropriate port. For more information, consult the relevant Unified CCE documentation.</td>
</tr>
</tbody>
</table>

Failed to connect to Authorization Server

Problem
When logging into ISE, the following error is reported:
- Failed to connect to the Authorization Server.

Sample Log File Entry 1
2013-01-14 10:58:37,421 ERROR [2736] ErrorHandling.ErrorBehaviorAttribute W6: Exception: Unauthorized (Unknown Username or Incorrect Password) [Authentication] [401] [Sender/Unauthorized]

Sample Log File Entry 2

Sample Log File Entry 3
at SyncInvokeEquipmentClusters(Object, Object[] inputs, Object[]& outputs)
at System.ServiceModel.Dispatcher.SyncMethodInvoker.Invoke(Object instance, Object[] inputs, Object[]& outputs)
at System.ServiceModel.Dispatcher.SyncMethodInvoker.Invoke(Object instance, Object[] inputs, Object[]& outputs)

Causes and Solutions

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>With no corresponding Unified CCMP Application Server log file entry</strong></td>
<td>The AW cannot connect to the Unified CCMP Authorization Server. Ensure that the specified Authorization Server port on the Unified CCMP Authorization Server has been configured in the firewall to allow inbound HTTPS traffic.</td>
</tr>
<tr>
<td><strong>With an entry in the Unified CCMP Application Server log file similar to sample log file entry 1</strong></td>
<td>There is no corresponding linked Unified CCMP user. Create a Unified CCMP user with a login name in the correct format, for example, <a href="mailto:iseuser1@testdom.local">iseuser1@testdom.local</a>.</td>
</tr>
<tr>
<td></td>
<td>The corresponding linked Unified CCMP user has not been enabled. In the Unified CCMP Web Application, select Tools &gt; Users, select the Unified CCMP user and tick the Account Enabled option.</td>
</tr>
<tr>
<td></td>
<td>The corresponding Unified CCMP user account has been locked due to multiple unsuccessful login attempts. In the Unified CCMP Web Application, select Security Manager &gt; Users, navigate to the Unified CCMP user and check that User Exceeded Maximum Login Attempts is not selected. If it is, clear it to reset the user account.</td>
</tr>
<tr>
<td><strong>Cause</strong></td>
<td><strong>Solution</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>The corresponding Unified CCMP user does not have the same password as the Windows active directory user that is being used to log into ISE (only for installations that do not use single sign on).</td>
<td>In the Unified CCMP Web Application, modify the password for the corresponding Unified CCMP user to match the password of the domain user. If the linked Unified CCMP user was created by importing from Unified CCE, and the linked Unified CCMP user has never logged in to Unified CCMP, then the Unified CCMP password may never have been set. In this case, log into Unified CCMP using the linked Unified CCMP user and set the password when prompted.</td>
</tr>
</tbody>
</table>

**With an entry in the Unified CCMP Application Server log file similar to sample log file entry 2**

<table>
<thead>
<tr>
<th><strong>Cause</strong></th>
<th><strong>Solution</strong></th>
</tr>
</thead>
</table>

**With an entry in the Unified CCMP Application Server log file similar to sample log file entry 3**

<table>
<thead>
<tr>
<th><strong>Cause</strong></th>
<th><strong>Solution</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The corresponding Unified CCMP user does not have permission to see the ICM.</td>
<td>In the Unified CCMP Web Application, select <strong>Security Manager &gt; Users</strong>, and ensure that this Unified CCMP user has a folder role that includes the Browse Dimensions task on the ICM folder, or is in a group that has such a folder role.</td>
</tr>
</tbody>
</table>
### Cause

There is a mismatch between some or all of:
- the ICM name in the registry on the AW
- the ICM name in the CCE AW
- the ICM name in Unified CCMP
- the ICM name supplied to ISE.

### Solution

Check the various ICM names as below (called ICR in some places), and ensure that the last three match the ICM name in the registry on the AW.

The ICM name in the registry on the AW:

![Registry Editor](image)

The ICM Instance Name in the AW:

![SQL Server Management Studio](image)
### Cause

| **The ICM name in the Unified CCMP database:** |

### Solution

The ICM name entered in ISE:

#### Unable to see required resources

**Problem**
ISE starts but the logged in user cannot see the required scripts or resources.

**Sample Log File Entry**
None.
## Causes and Solutions

<table>
<thead>
<tr>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Unified CCMP user does not have a folder role that includes <strong>Browse Dimensions</strong> on the folder containing the required scripts or resources.</td>
<td>In the Unified CCMP web application, select <strong>Tools &gt; Security</strong>. On the <strong>Users</strong> tab, select the checkbox beside the user, then click <strong>Change Permissions</strong>. Assign a suitable folder role that includes <strong>Browse Dimensions</strong> to the folders containing the scripts and resources you want this linked user to be able to access.</td>
</tr>
</tbody>
</table>
6. Auditing and Monitoring

Unified CCMP enables provisioning users to view the audit histories of individual items.

These audit trails display events that relate to operations that have been performed within the platform, such as move agent, delete skill group and so forth.

In addition to the standard platform audit information admin users can use system logs and performance counters to further aid problem diagnosis or establish system status.

Audit Histories

Resource Audit History

Each individual resource has its own audit history, showing all the events that have occurred on that resource. This can be accessed from the History tab when examining the resource in the Unified CCMP System Manager (see the User Guide for Cisco Unified Contact Center Management Portal). This information can be used for problem diagnosis relating to a particular remote resource or to identify when a particular change was made and by whom.

Using the Edit Filter link available on the History tab allows you to view only events which were successful, events which failed, or to view events that took place between certain dates. You can click on some of these events to see more details.

Activity Monitor

The Unified CCMP System Manager includes an Activity Monitor tool which allows you to:

- view the items currently in the provisioning queue
- view audit details for resources, filtered by any or all of the resource type, location, date range, and the provisioning outcome (success or failure).

You can click on an item to see more information about the event. See the User Guide for Cisco Unified Contact Center Management Portal for more information.

Logging

Unified CCMP provides an extensive logging framework for each of the components of the system to aid troubleshooting in the event of a problem.

Logging trace levels are stored in the registry for each separate component and may be set to one of the four following values:
Chapter 6: Auditing and Monitoring

Logging

<table>
<thead>
<tr>
<th>Logging Level</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ERROR</td>
<td>This is the lowest level of logging. It will only log information relating to exceptions that occurred in the application.</td>
</tr>
<tr>
<td>1</td>
<td>WARN</td>
<td>Warn provides ERROR level logging plus warnings raised for potential system issues.</td>
</tr>
<tr>
<td>2</td>
<td>INFO</td>
<td>Info is the default logging level. It provides ERROR and WARN as well as standard diagnostic information.</td>
</tr>
<tr>
<td>3</td>
<td>DEBUG</td>
<td>Debug is the highest level of logging. It provides detailed information of every operation that is performed. Debug logging has an adverse effect on performance, its usage should be kept to a minimum.</td>
</tr>
</tbody>
</table>

Logging levels are defined on a per component basis and may be configured at the following registry locations:

<table>
<thead>
<tr>
<th>Component</th>
<th>Registry Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Application</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Exony\Components\Web\TraceLevel</td>
</tr>
<tr>
<td>Application Server</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Exony\Components\Application Server\TraceLevel</td>
</tr>
<tr>
<td>Partitioning Service</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Exony\Components\Partitioning\TraceLevel</td>
</tr>
<tr>
<td>Provisioning Server</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Exony\Components\Provisioning\TraceLevel</td>
</tr>
<tr>
<td>Data Import Server</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Exony\Components\Data Pipeline\TraceLevel</td>
</tr>
</tbody>
</table>

Updating the logging level in the registry will require the associated process to be restarted before the change will take effect.

Application Server Log

Logs may be located on the Web Application Server. Navigate to the location where the Application Server Component was installed. By default, this is C:\Program Files\Management Portal\Application Server. Open the latest log file contained within the Logs folder.
Web Application Log

Logs may be located on the Web Application Server. Logs will be placed relative to the location where the Web Application Component was installed. By default, the log location is *C:\Program Files\Management Portal\Web Logs*. Open the latest log file contained within the *Logs* folder.

Data Import Server Log

Logs will be located on the DB Server. Navigate to the location where the Database Component was installed. By default, this is *C:\Program Files\Management Portal\Data Import Server*. Open the latest log file contained within the *Logs* folder.

Provisioning Server Log

Logs will be located on the DB Server. Navigate to the location where the Database Component was installed. By default, this is *C:\Program Files\Management Portal\Provisioning*. Open the latest log file contained within the *Logs* folder.

Partitioning Log

Logs will be located on the DB Server. Navigate to the location where the Data Import Server Component was installed. By default, this is *C:\Program Files\Management Portal\Partitioning*. Open the latest log file contained within the *Logs* folder.

Installer Logs

Platform install logs will be placed in *C:\InstallLogs*. These files will provide the MSI logging output from the installation of Unified CCMP.

The various internal custom actions launched by the installer will also generate their own log files allowing problem diagnosis of custom exceptions (often reported as Error 1001 by Windows Installer). These files will be placed in the *InstallLogs* folder under the Unified CCMP installation folder for example, *C:\Program Files\Management Portal\InstallLogs*.

IIS Log Files

Web log files are found at *C:\WINDOWS\system32\LogFiles\W3SVC1\ex<YYMMDD>.log*. These contain details of all web server transactions, and refer to standard HTTP status codes.

A full list of HTTP status codes can be found at [http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html](http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html). Some routine codes include:

- 200 - OK
- 401 - Failed Authorization
- 404 - Page Not Found
- 500 - Internal Server Error

**Performance Counters**

Unified CCMP integrates with Windows performance counters (accessed by running the `perfmon` command) to provide real-time activity monitoring. Unified CCMP appears across several objects in perfmon, each with a number of associated performance counters.

The perfmon graph can combine many different performance counters. Furthermore, perfmon can be configured to trace specific counters at scheduled times of the day. These performance logs can then be exported to Excel for further analysis. Perfmon can also connect to remote computers, if necessary.

For information on how to use and configure perfmon, see the Microsoft documentation on Performance Logs and Alerts.

**Unified CCMP Data Pipeline Object**

<table>
<thead>
<tr>
<th>Counter</th>
<th>Monitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Cache Reloads</td>
<td>Number of times a cache has been reloaded</td>
</tr>
<tr>
<td>Total Database Downloads</td>
<td>Total number of database downloads</td>
</tr>
<tr>
<td>Total Database Requests</td>
<td>Total number of database requests</td>
</tr>
<tr>
<td>Total Database Statements</td>
<td>Total number of TSQL statements</td>
</tr>
<tr>
<td>Total Database Transactions</td>
<td>Total number of database transactions</td>
</tr>
<tr>
<td>Total Directory Rollbacks</td>
<td>Total number of import directories rolled back</td>
</tr>
<tr>
<td>Total Microflow Validation Errors</td>
<td>Total number of microflows that have failed validation testing</td>
</tr>
<tr>
<td>Total Microflows Run</td>
<td>Total number of microflows run</td>
</tr>
<tr>
<td>Total Number Imports</td>
<td>Total number of imports started</td>
</tr>
<tr>
<td>Total Replication Imports</td>
<td>Total number of directories imported on the Subscriber</td>
</tr>
<tr>
<td>Total Replication Publisher Requests</td>
<td>Total number of directories sent for replication</td>
</tr>
<tr>
<td>Total Rows Imported</td>
<td>Total number of rows imported</td>
</tr>
</tbody>
</table>
### Unified CCMP Application Server Object

<table>
<thead>
<tr>
<th>Counter</th>
<th>Monitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Requests/Second</td>
<td>Application requests processed per second</td>
</tr>
<tr>
<td>Application Requests/Total</td>
<td>Total application requests processed</td>
</tr>
<tr>
<td>Available I/O Threads</td>
<td>The difference between the maximum number of thread pool IO threads and the number currently active</td>
</tr>
<tr>
<td>Available Worker Threads</td>
<td>The difference between the maximum number of thread pool worker threads and the number currently active</td>
</tr>
<tr>
<td>Max IO Threads</td>
<td>The number of requests to the thread pool that can be active at the same time. All requests above that number remain queued until thread pool IO threads become active.</td>
</tr>
<tr>
<td>Max Worker Threads</td>
<td>The number of requests to the thread pool that can be active at the same time. All requests above that number remain queued until thread pool worker threads become active.</td>
</tr>
<tr>
<td>Min IO Threads</td>
<td>The minimum number of idle asynchronous IO threads currently maintained by the thread pool.</td>
</tr>
<tr>
<td>Min Worker Threads</td>
<td>The minimum number of idle worker threads currently maintained by the thread pool.</td>
</tr>
<tr>
<td>Total Failed Logons</td>
<td>Total number of failed logons</td>
</tr>
<tr>
<td>Total Failed Logons/Second</td>
<td>Total number of failed logons per second</td>
</tr>
<tr>
<td>Total Logon Attempts</td>
<td>Total number of logon attempts</td>
</tr>
<tr>
<td>Total Logon Attempts/Second</td>
<td>Total number of logon attempts per second</td>
</tr>
<tr>
<td>Total Successful Logons</td>
<td>Total number of successful logons</td>
</tr>
<tr>
<td>Total Successful Logons/Second</td>
<td>Total number of successful logons per second</td>
</tr>
</tbody>
</table>
Unified CCMP Provisioning Object

<table>
<thead>
<tr>
<th>Counter</th>
<th>Monitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total ConAPI Add Requests</td>
<td>Total number of add requests sent on each ConAPI connection since the service last started</td>
</tr>
<tr>
<td>Total ConAPI Get (Alternate) Requests</td>
<td>Total number of get (alternate) requests sent on each ConAPI connection since the service last started</td>
</tr>
<tr>
<td>Total ConAPI Get (Primary) Requests</td>
<td>Total number of get (primary) requests sent on each ConAPI connection since the service last started</td>
</tr>
<tr>
<td>Total ConAPI Remove Requests</td>
<td>Total number of remove requests sent on each ConAPI connection since the service last started</td>
</tr>
<tr>
<td>Total ConAPI Update Requests</td>
<td>Total number of update requests sent on each ConAPI connection since the service last started</td>
</tr>
</tbody>
</table>

Unified CCMP <Service Type> Connection Health Object

<table>
<thead>
<tr>
<th>Counter</th>
<th>Monitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health</td>
<td>The health of the connections from this service to each of the listed servers.</td>
</tr>
</tbody>
</table>

Unified CCMP <Service Type> Connection Requests

<table>
<thead>
<tr>
<th>Counter</th>
<th>Monitors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Requests/Second</td>
<td>Connection requests that this service has processed per second</td>
</tr>
<tr>
<td>Connection Requests/Total</td>
<td>Total connection requests that this service has processed</td>
</tr>
</tbody>
</table>

Configuring SNMP Traps

Simple Network Management Protocol (SNMP) traps may be raised from Unified CCMP by configuring Windows to send selected events to an SNMP monitor. This is achieved using a Windows utility called *evntwix.exe*. This utility converts events written to the Windows Event log into SNMP traps that are raised and forwarded by the Windows SNMP service to an SNMP management tool.

To configure SNMP traps for use with Unified CCMP follow these steps:
Enable the Windows SNMP Feature

To configure Windows event forwarding to SNMP, the SNMP feature in Windows must be enabled. To do this, on the Unified CCMP server containing the component for which traps are required:

1. From the Start menu, select **All Programs > Administrative Tools > Server Manager**.
2. In the Server Manager left hand pane, right-click the **Features** option and select **Add Features**.
3. In the Add Features Wizard window, select **SNMP Services** and expand it to ensure that both **SNMP Service** and **SNMP WMI Provider** are also selected.
4. Click **Next** and then **Install** to complete the deployment of SNMP. Close the Server Manager.
5. From the **Start** menu, select **All Programs > Administrative Tools > Services**.
6. Locate the SNMP Service, right-click and select **Properties**.
7. In the **Security** tab ensure **Send authentication trap** is selected and, in the Accepted community names section, click **Add**.
8. Select **READ ONLY** for community rights and enter a custom **Community Name** to restrict access through SNMP.
9. Click **OK** to complete the configuration of the SNMP Service. Close the Services window.

Configure the SNMP Service for Trap Forwarding

Next, the SNMP Service must be configured to forward traps to the management tool that is being used for reporting and alerting.

1. From the Start menu, select **All Programs > Administrative Tools > Services**.
2. In the list of services, locate the **SNMP Service**, right-click and select **Properties**.
3. On the **Traps** tab, enter **public** in the Community name field and click **Add to List**.
4. Click **Add** below the Trap destinations field and in the SNMP Service Configuration dialog box, enter the host name or IP address of the system that will be receiving the trap information (that is, the server hosting the management agents or reporting and alerting tools). Click **Add** to add the trap destination.
5. If there is more than one system that needs to receive the trap information, repeat step 4 for each of the other servers.
6. Click **OK**, then close the Services window.
Configure Windows Events to forward to SNMP

Finally, use the `evntwin.exe` tool to configure the Windows events to be forwarded as SNMP traps. Any event that is raised in the Windows Event Log may be configured to generate an SNMP trap.

1. From the **Start** menu, select **Run**, and enter `evntwin.exe`.
2. Select **Custom**, then click **Edit**.
3. In the Event Sources list, expand the **Application** source to see the available Unified CCMP events. The Unified CCMP events and their meanings are given in the table below.

<table>
<thead>
<tr>
<th>Event Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UCCMP Application Server Monitoring</td>
<td>The core monitoring service for the application server. This posts connection change events to the event log.</td>
</tr>
<tr>
<td>UCCMP Data Import Server Monitoring</td>
<td>The data import service used for importing data from CCE etc.</td>
</tr>
<tr>
<td>UCCMP Partition Table Manager Monitoring</td>
<td>Connection monitoring for the partition manager service (which creates partitioning tables in the database).</td>
</tr>
<tr>
<td>UCCMP Provisioning Server Monitoring</td>
<td>Service used for provisioning changes on remote equipment, for example, CCE etc.</td>
</tr>
<tr>
<td>UCCMP: Partition Table Manager</td>
<td>Core application service for creating partitioning tables in the database.</td>
</tr>
<tr>
<td>X_ANALYTICALDATA, X_HIERARCHY, X_IMPORTER etc.</td>
<td>These are the individual services configured in Windows for Unified CCMP. These applications can be used for subscribing to standard service events, for example, start/stop events etc.</td>
</tr>
</tbody>
</table>

4. To configure an event source to generate SNMP traps, select the event source, wait a few moments, then click **Add** once it is enabled. In the Properties dialog, specify the trap properties required, then click **OK**.
5. When you have finished setting the SNMP traps you require, click **Apply**.
7. Standard Administrative Operations

This section provides basic information on performing every-day administrative procedures that are required for the system to operate correctly. This includes such activities as the resetting of system account passwords should a domain policy be enforced that requires passwords to be reset within a given time range.

Service Restart Configuration

All Unified CCMP services are configured to start automatically, and restart automatically on failure. However three consecutive failures of a service will cause a system restart. To alter this behavior:

1. From Start menu, run services.msc.
2. Double-click to open each Unified CCMP service in turn.
4. Set the response to all the failures to be Restart the Service (changing the Subsequent Failures entry).
5. Click OK.

Resetting Default Database Connections

Unified CCMP provides a Windows client utility allowing for default database connections to be updated for the various components of the system. When Unified CCMP is installed configured connection strings are encrypted and stored in the configuration files specific to each component. In some scenarios it is necessary to update these encrypted connection strings so that the component is able to establish a connection to the database. Common scenarios where this is required are as follows:

- Moving the Unified CCMP Database to a new server
- Expiry of a SQL Server account used at install time

This section outlines the usage of the Connection Updater Tool. This tool allows for resetting the connection settings for the relational database used by various Unified CCMP components.

The Connection Updater tool is installed on the system alongside each of separate Unified CCMP component. The tool can be found in the installation directory of an installed Unified CCMP component. This tool is intended to be used when the connection settings to the Unified CCMP relational database defined at install time, have been setup incorrectly. This tool can also be used to change the settings for any
other reason like, switching between Windows Authentication and SQL Server Authentication.

**Connection Updater Features**

The Connection Updater tool can be launched using the `ConnectionUpdater.exe` file contained in the installation folder for each component.

To find the tool navigate to installation directory of the Unified CCMP component using Windows Explorer. Typically, this path would be `C:\Program Files\Management Portal\Application Server` for the Application Server component. Double click the executable `ConnectionUpdater.exe`. The Connection Updater tool will open:

![Connection Updater Tool](image)

When the tool loads, it will check all the installed Unified CCMP components on this server and list the Unified CCMP Services which support resetting of the default database connection settings. In the above screen you can see all the Unified CCMP components are installed on a single server.

The Connection Updater tool allows you to change the connection settings for an individual component one by one or all the components together. The following
figure shows the default relational database connection settings for the Unified CCMP Data Import Server.

**Figure 7-2  Connection Settings for Unified CCMP Data Import Server**

In this example, you can switch to view the connection settings for other Unified CCMP component services by clearing the Data Import Server check box and selecting the check box for any other component.

If you select more than one Unified CCMP Service the tool will show the default Connection Settings and not the active configuration of any specific Services.

**Connection Updater Usage**

The Connection Updater tool allows you to change the following details for the relational database connection settings

- **Server Name.** This is the database server name when the Unified CCMP database is installed. Default is *localhost*.  
- **Catalog.** The Unified CCMP database name. Default is *Portal*. 
• **Authentication.** The authentication method for the database connection. The default is Windows Authentication. You may change this to use SQL Server Authentication. If SQL Server Authentication is used then you will need to provide details for the SQL Server User Name and Password.

Select one or more Unified CCMP Services in the Services list by checking the checkboxes provided. Change the connection credentials in the **Connection Settings** section and click the **Update** button to apply the changes.

**Testing Connections**

You can use the **Test** button to test the connection details provided.

This test will be a valid if you have chosen SQL Server Authentication to connect to the database. If you have chosen to authenticate using Windows Authentication, then the test will use the credentials of the user running the Connection Updater tool. This may not be the user configured to run the respective services (typically **NETWORK SERVICE**).

**Restart Services**

Any changes to the connection settings made through the Connection Updater tool will require the related services to be restarted before they will take effect. Checking the checkbox **Restart Services** will automate the restart of the associated services when the Update button is pressed.
8. Advanced Administrative Operations

This section provides information on advanced administrative operations. This includes the configuration and management of cluster resources in the event of a failure and advanced procedures to be performed to restore a failed system.

Enabling and Disabling Cluster Configuration Components

This section describes the effects of enabling and disabling the various objects in the Unified CCMP cluster configuration model. Each of these objects has an Enabled property which can be set to true or false using the ICE Cluster Configuration tool (see section Servers Page).

When you disable a connection in the cluster configuration model, the connection is no longer available for use. In a single-sided system that functionality is unavailable until the connection is re-enabled. A dual-sided system will reconfigure itself to use an alternate connection if possible. In this case, the system chooses to use the connection that has the lowest cost (see section Cluster Configuration Connection Support) from those that are available and enabled. If a connection with a lower cost subsequently becomes available and enabled, the system will automatically reconfigure itself to use that connection.

Table 8-1 lists the objects in the cluster configuration model (see section Cluster Configuration Model for more information about these objects) and the effects of changing the Enabled property for each of these objects.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Indicates if this server is enabled. This is a calculated field, and indicates whether all physical resource components on this server are enabled. Changing this value updates the enabled property of all physical resource components on this server.</td>
</tr>
<tr>
<td>Physical Resource Component</td>
<td>Indicates if this physical resource component is enabled. Changing this value also changes the enabled state of the connections to and from the component.</td>
</tr>
<tr>
<td>Physical Resource</td>
<td>Indicates if this physical resource is enabled. This is a calculated field and indicates whether all physical resource components in this physical resource are enabled. Changing this value updates the enabled flag of all physical resource components in this physical resource.</td>
</tr>
</tbody>
</table>
### Database Backup and Recovery

The Data Import Server component has a configuration attribute to stop it processing microflows at a specified time of the day. This allows the Data Import Server component service to be left running even though microflows are not being processed. The advantage of this approach is that health monitoring applications will not raise alerts, such as SNMP traps, because the service is up and running.

Disabling the Data Import Server can be used to stop importing when SQL Server backups are taken. Do not allow backups at the same time as data is being imported because the database does not have a consistent state. Database backups are typically automated and run at a predefined time of the day.

The Data Import Server is enabled through the `EnabledTime` attribute in the Data Import Server service configuration file (`DataPipelineService.exe.config`). In the example below, the Data Import Server processes microflows from 3:00 through to 2:00 (24 hour clock). This effectively disables the Data Import Server for an hour at 2am. Note that an import cycle could start just before 2:00 and so may still be running after 2:00.

```xml
<add key="EnabledTime" value="03:00-02:00" />
```
9. Troubleshooting

This section provides information on commonly observed issues and the steps to be performed to identify and resolve Unified CCMP related issue. It also includes information on support tools provided with Unified CCMP.

DBCheck

The DBCheck utility automates the execution of health check queries and repairs for the Unified CCMP database. DBCheck provides an automated summary of potential data integrity issues that may affect system stability.

The Unified CCMP database holds the core resources and state machine states that drive the closed loop provisioning operations of the Unified CCMP product. The DBCheck tool is a Support utility that allows the health of the Unified CCMP database catalog to be checked and repaired.

To run DBCheck, you need SQL admin permissions on the Portal database catalog.

Note

Ensure that you have a current back up of the Portal database before executing any repair operations with DBCheck.

Note

The DBCheck tool must be used with caution. Although DBCheck is designed for detecting and repairing potential data integrity issues, do not run this tool repeatedly, since the repair process impacts database performance and may appear to make minor problems worse. If you have frequent issues with data integrity, contact your vendor for help with addressing the underlying issues.

Overview

DBCheck is a console tool that is installed with the Database component of Unified CCMP. It uses a set of rules located in XML files to perform a range of check operations on the database, if errors are found the user can choose to repair them.

During the check process if errors are found then the tool can save the error records plus the relevant product logs so that detailed off-line analysis may be performed.

Rules files can be updated independently of the DBCheck tool itself. Only Unified CCMP supplied rules files can be used with the DBCheck tool. Rules files are signed, so if a rules file is edited DBCheck will no longer accept the file.
Architectural Background

The Unified CCMP database is a Microsoft SQL Server database that holds the configuration, security, and provisioning and audit data for the product. The product may be operated in a high availability mode using a pair of Side A and Side B database servers synchronized with standard SQL Server transactional replication.

The Unified CCMP database catalog is written to by the following services:

- **Web/Application Server.**
  User requests are received via the product web pages and persisted into the catalog. The usual operation here is users peruse their data and make the occasional provisioning request. Some sites use bulk provisioning to make large numbers of provisioning requests. These are all validated and queued into the Unified CCMP database catalog.

- **Provisioning Server.**
  This service reads the provisioning requests and uses the appropriate workflows to apply them to the related Unified CCE(s) and Unified CM(s) using the Cisco ConAPI and AXL APIs. This is a regulated activity that protects the back-end equipment when very large bursts of activities occur. The results of the provisioning operations are written back to the Unified CCMP database catalog as either successful (items are ready/deleted) or failed (error state).

- **Data Import Server.**
  This service operates in the reverse direction of the Provisioning Server and reads the configuration data from the Unified CCE(s) and Unified CM(s). It applies read data to the data model held in the Unified CCMP database. By default, this operation occurs every 15 minutes.

- **Transactional Replication.**
  Write operations committed into the partner Unified CCMP database catalog are replicated across the network and written to the local database catalog. For information on this standard technology please see http://technet.microsoft.com/en-us/sqlserver/cc511480.aspx

Installation

DBCheck is installed with the Unified CCMP Database component. The DBCheck tool is located in C:\Program Files\Management Portal\Database\DbCheck if the default installation options are selected.

Configuration

The DbCheck.exe.config file contains the configuration information which may need editing to match a specific installation.
### Key

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProvLogLocation</td>
<td>The directory path to the Provisioning Server logs that will be collected as part of the Save command or when run in batch mode.</td>
<td>C:\Program Files\Management Portal\Provisioning Server\LOGS</td>
</tr>
<tr>
<td>ImportLogLocation</td>
<td>The directory path to the Data Import Server logs that will be collected as part of the Save command or when run in batch mode.</td>
<td>C:\Program Files\Management Portal\Data Import Server\LOGS&quot;</td>
</tr>
<tr>
<td>RuleLocation</td>
<td>The directory path to the location of the Rules files.</td>
<td>.\Rules\</td>
</tr>
<tr>
<td>OutputLocation</td>
<td>The directory path to the location where the summary and logs files will be saved as part of the Save command or summary rules.</td>
<td>.\Output\</td>
</tr>
<tr>
<td>PrimaryConnectionString</td>
<td>The connection string to the Unified CCMP SQL Server database which is the primary database in case of a dual sided Unified CCMP setup.</td>
<td>Integrated Security=SSPI; Persist Security Info=False; Initial Catalog=Portal; Data Source=(local)</td>
</tr>
<tr>
<td>SecondaryConnectionString</td>
<td>The connection string to the secondary Unified CCMP SQL Server database in case of a dual sided setup.</td>
<td></td>
</tr>
<tr>
<td>SqlCmdTimeOut</td>
<td>The command timeout in seconds used when reading and writing to the SQL Server Portal database.</td>
<td>600</td>
</tr>
<tr>
<td>ErrorTextColor</td>
<td>The console color used in interactive mode to highlight the rules that have errors after a Check command is executed.</td>
<td>Red</td>
</tr>
<tr>
<td>InfoTextColor</td>
<td>The console color used in interactive mode to show the error row’s details when using the Results &lt;rule id&gt; command.</td>
<td>Yellow</td>
</tr>
<tr>
<td>MonitoredServiceNames</td>
<td>The service name fragments that a Repair operation will shut down before beginning the repair operation. <strong>Note: this setting should not be changed.</strong></td>
<td>&quot;_IMPORTER;_PROVISIONING&quot;</td>
</tr>
</tbody>
</table>
Ensure the configuration matches the system configuration before executing the DBCheck tool.

Running DBCheck

DBCheck can be executed from the command line by running the DBCheck.exe file from the installation location (typically C:\Program Files\Management Portal\Database\DbCheck).

In a dual sided Unified CCMP Database setup, DBCheck must be executed against the database server that acts as the Primary (Publisher) Unified CCMP Database. The tool will do the relevant checks using the Primary Connection to the Unified CCMP database. The tool will exit immediately if it being run against the Secondary Unified CCMP database.

Once initiated the following commands may be executed to monitor system data integrity and repair data in the event of a reported issue.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>help</td>
<td>A brief description of all the interactive commands is displayed.</td>
<td>help</td>
</tr>
<tr>
<td>list</td>
<td>Displays the titles of all the rules that have been read from the Rules directory.</td>
<td>list</td>
</tr>
<tr>
<td>list &lt;rule id&gt;</td>
<td>Displays detailed information for the specified rules.</td>
<td>list R01 R02 R05</td>
</tr>
<tr>
<td>check</td>
<td>Runs the check functionality of all the rules and displays the summary details to the screen. <strong>Note:</strong> The results are not logged to the output directory. Use the save command immediately after the check command to save the results to the output directory.</td>
<td>check</td>
</tr>
<tr>
<td>check &lt;rule ids&gt;</td>
<td>Runs the check functionality of just the specified rule(s) and displays the summary details to the screen. <strong>Note:</strong> The results are not logged to the output directory. Use the save command immediately after the check &lt;rule ids&gt; command to save the results to the output directory.</td>
<td>check R01 R02 R05</td>
</tr>
</tbody>
</table>
### Command Description Example

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>repair</td>
<td>Runs the check functionality of all the rules and, if there is an error, runs the corresponding repair actions. Note the results are only shown to the screen and are not logged to the output directory. If required, the “save” command should be used after the repair operation to write the results to the output directory. <strong>Note:</strong> The results are not logged to the output directory. Use the save command immediately after the repair command to save the results to the output directory. <strong>Note:</strong> Before executing a repair operation, DBCheck stops the Data Import and Provisioning services. After the repair, DBCheck restarts the services. It is important to check that the services have restarted correctly.</td>
<td>repair</td>
</tr>
<tr>
<td>repair &lt;rule ids&gt;</td>
<td>Runs the check functionality for the specified rule(s) and, if there is an error, runs the corresponding repair actions. Note the results are only shown to the screen and are not logged to the output directory. If required, the “save” command should be used after the repair operation to write the results to the output directory. <strong>Note:</strong> Before executing a repair operation, DBCheck stops the Data Import and Provisioning services. After the repair, DBCheck restarts the services. It is important to check that the services have restarted correctly.</td>
<td>repair R01 R02 R05</td>
</tr>
<tr>
<td>results</td>
<td>Shows the summary details of the last run check.</td>
<td>results</td>
</tr>
<tr>
<td>results &lt;rule ids&gt;</td>
<td>Shows the detailed rows of the specified rules.</td>
<td>results R01 R02 R05</td>
</tr>
<tr>
<td>save</td>
<td>Saves the results of last check or repair operation to the output directory. If there were no errors detected then a simple summary is saved otherwise the detailed error rows plus the Data Importer and Provisioning Server logs are saved.</td>
<td>save</td>
</tr>
<tr>
<td>clean</td>
<td>Deletes all the saved sessions from the output directory. The user is first prompted to confirm before deletion takes place.</td>
<td>clean</td>
</tr>
<tr>
<td>cls</td>
<td>The screen contents are cleared</td>
<td>cls</td>
</tr>
<tr>
<td>exit</td>
<td>Exit interactive mode and restart the Data Import and Provisioning Service.</td>
<td>exit</td>
</tr>
</tbody>
</table>
Logging and Error Reporting

By default, DBCheck writes all of its console output to a text file in the installation directory called DbCheck.log. This log file can be used to troubleshoot potential issues for example, database connectivity errors, when the tool is used.

If a save command or a batch operation is performed then the tool executes the check queries, records the results, copies the essential log files for the last 24 hours and generates a high level summary of results. A new folder is created in the Output folder with a name derived from the date-time in the following format:

    yyyy_MM_dd_hh_mm_ss_<Flag>

where Flag = E for errors found or S for success (no errors)

This folder contains the following items:

- Dbcheck Check Summary.html
- Dump files containing query results for any check queries that returned results.
- ProvisioningServerLogs folder containing log files for the Provisioning Server for the last 24 hours.
- IMPORTERLogs folder containing log files for the Data Import Server for the last 24 hours.

Reviewing Logs

When check rules return errors then the saved logs should be analyzed before a repair is performed. Some rules such as “In Error Items” return items that have been in the Error status for longer than 24 hours.

It may be perfectly valid that items are in error state, for example the creation of an IP Phone may have failed because Unified CM has reached a license limit. In this scenario, running a repair would remove the IP Phones in error status from the Unified CCMP database and they would not be provisioned on the Unified CM.

The correct process for this scenario would be to identify the licensing exception from the logs, add additional licenses to Unified CM and then re-save the IP Phones through the Unified CCMP System Manager.

Troubleshooting DBCheck

If a DBCheck repair returns an error, review the execution log. If a database timeout occurred, then change the timeout configuration, reload the tool and execute the command again.
Unified System CLI

About Unified System CLI
Cisco Unified System CLI is a command line support tool for Cisco support engineers. It provides a common interface to control logging and diagnostics. Cisco Unified System CLI can be run from Unified CCMP to configure and collect diagnostic information from Unified CCMP.


Installing Unified System CLI
Unified System CLI is installed with the Diagnostic Framework (see Installation and Configuration Guide for Cisco Unified Contact Center Management Portal for more information).

Starting Unified System CLI
To start Unified System CLI, in a command window:
1. Click Start > All Programs > Management Portal > Unified System CLI. A command window opens.
2. At the Enter username: prompt, enter wsmadmin.
3. At the Enter password: prompt, enter the password that was specified for the wsmadmin user when the Diagnostic Framework was installed.
4. At the Enter Instance[][](Optional): prompt, press Enter. Do not change the instance you specified on the command line using the devicetype keyword as the Unified CCMP implementation of Unified System CLI does not support this.
5. See section Unified System CLI Command Reference for a list of commands available.
6. To exit Unified System CLI, type exit.

Getting Help
To get help about Unified System CLI syntax, enter help
To see the list of available commands, enter ?
To see the options for a command, <command>, enter <command> ?
You can add one or more optional parameters to `<command> ?` to show the next level of options available. For example:

- **show ?** lists the various items you can view using the show command.
- **show log ?** lists the options for controlling the log information.
- **show log redirect ?** lists the options for redirecting the location that the log output is sent to.
- **show log redirect file ?** lists the valid syntax options for specifying the filename if you have chosen to send the log output to a file.

To see more complete help for a command, `<command>`, including a description of the command and the options available, select the command from the table below and enter:

```
help <command>
```

### Unified System CLI Command Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>capture start</td>
<td>Not supported.</td>
</tr>
<tr>
<td>capture stats</td>
<td>Not supported.</td>
</tr>
<tr>
<td>capture stop</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>
| debug level     | Sets the logging level for the Unified CCMP components installed on the system.  
<pre><code>               | Valid values are:                                                           |
               | 0  Error                                                                    |
               | 1  Warn                                                                     |
               | 2  Info                                                                     |
               | 3  Trace                                                                    |
               | 4  Debug                                                                    |
               | 5  Not supported                                                            |
               | 99  Not supported                                                           |
</code></pre>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>show all</td>
<td>Returns a combined set of results from the various show commands in single zip file (by default, covering the last 24 hours). Filter results using <strong>component</strong>, <strong>reltime</strong> and <strong>absdatetime</strong>. Specify the output location using <strong>redirect file</strong> to send the output to a text file, or <strong>redirect dir</strong> to send the output to a zip file in a folder.</td>
</tr>
<tr>
<td>show component</td>
<td>Returns a list of components installed on the system. You can specify a component on the command line to return only the results for that component. If the component name includes spaces, enclose the name in double quotes (&quot; &quot;). For example: <strong>show component &quot;ccmp:Application Server&quot;</strong></td>
</tr>
<tr>
<td>show config</td>
<td>Extracts the registry content for Unified CCMP components to the specified file. Note. This command has limited use for Unified CCMP since it is not possible to apply the extracted registry configuration to other machines.</td>
</tr>
<tr>
<td>show debug</td>
<td>Prints the current trace level for the installed components. If passed a component name then only the trace level for that component is returned.</td>
</tr>
<tr>
<td>show devices</td>
<td>Shows the name of the installed product.</td>
</tr>
<tr>
<td>show license</td>
<td>Not supported.</td>
</tr>
<tr>
<td>show log</td>
<td>Obtains log files for the specified date/time range and components, and store them at the specified location. Filter results using <strong>component</strong>, <strong>reltime</strong> and <strong>absdatetime</strong>. Specify the output location using <strong>redirect file</strong> to send the output to a text file, or <strong>redirect dir</strong> to send the output to a zip file in a folder.</td>
</tr>
<tr>
<td>show perf</td>
<td>Not supported.</td>
</tr>
<tr>
<td>show platform</td>
<td>Returns system related information about the machine on which Unified System CLI is running.</td>
</tr>
<tr>
<td>show processes</td>
<td>Not supported.</td>
</tr>
<tr>
<td>show sessions</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>
**Command** | **Description**
--- | ---
**show tech-support** | Equivalent to **show all**.
**show trace** | Obtains trace files for the specified date/time range and components, and store them at the specified location. Filter results using **component**, **reltime** and **absdatetime**. Specify the output location using **redirect file** to send the output to a text file, or **redirect dir** to send the output to a zip file in a folder.
**show version** | Shows the installed version of software. Note that the build number is not supported.
**system** | Enter system mode. The prompt changes from **admin:** to **admin(system)**. System mode gives you access to additional options for some commands. To exit system mode, type **exit**.

**General Troubleshooting**

**Delays in Importing Agent Changes**

If you make a change to an Agent in Unified CCE, most changes will be imported into CCMP promptly. But if you change the domain account for a Supervisor Agent in Unified CCE, then there may be a delay of up to 24 hours before the change is reflected in CCMP. This is the expected behavior.

**Web Portal Timing Dialogs**

If you run the Unified CCMP web application from a browser session on the web/app server itself, you will see some diagnostic timing information about the web page display times in the top right of the browser window. You can:

- click on an individual time to see more details about the actions taken
- click on **c** at the bottom right of the list to clear the current list
- click on **m** at the bottom left of the list to minimise the list.

If you run the Unified CCMP web application from anywhere else, the diagnostic timing information is not displayed.

**Installing the UCCE Config Web Service Certificate**

By default, CCMP ignores untrusted certificate warnings about the Unified CCE ConfigWebService certificate (the **Ignore Certificate Warnings** property for the Unified CCE config web service is **True** by default). But if the **Ignore Certificate**
Warnings property for the Unified CCE config web service has been set to False in the ICE tool, then you will need to install the Unified CCE ConfigWebService security certificate before CCMP will work properly.

If you do not do this, CCMP will not work properly and you will see the error “Could not establish trust relationship for the SSL/TLS secure channel with authority” in the system log. The ICE tool will also report this error if you try to test the connection to the Unified CCE instance.

To fix this error you need to:
• install the certificate in the user certificate store of each CCMP database server
• install the certificate in the computer certificate store of each CCMP database server
• (optionally) install the Unified CCE ConfigWebService security certificate in the user certificate store of each user who wants to run ICE and test connections, on each machine they want to be able to run ICE from.

Installing the Security Certificate in the User Certificate Store

To install the Unified CCE ConfigWebService security certificate in the user certificate store, you need to locate the certificate and import it into your certificate store.

On each CCMP database server:

1. Click Start > All Programs > Management Portal > Configuration Tools > Integrated Configuration Environment to start ICE. The Database Connection dialog box is displayed.
2. Enter the credentials for your database. If you see a dialog box showing the errors and warnings, click OK.
3. In the ICE Cluster Configuration tool, select the Resources tab and navigate to the Unified CCE instance. Select the Components tab. From this you can determine the URL of the Unified CCE ConfigWebService.
4. In Internet Explorer, navigate to the URL you found above. If the certificate has not been installed on this server, you will see a certificate error.
5. Click Certificate Error in the top right hand corner of the window.
6. In the Untrusted Certificate dialog box, select View Certificates.
7. In the Certificate dialog, note the “Issued to:” name (you will need this name to locate the certificate again below) and click Install Certificate.
8. In the Certificate Import Wizard, click Next.
9. In the Certificate Store dialog box, select Place all certificates in the following store, and click Browse. Choose Trusted Root Certificate Authorities and click OK to return to the Certificate Store dialog box.
10. In the Certificate Store dialog box, click **Next**. Review the settings and click **Finish** to complete the certificate import wizard.

11. If you see a security warning, click **Yes**, to import the certificate. When the import completes, click **OK**.

**Installing the Security Certificate in the Computer Certificate Store**

To install the Unified CCE ConfigWebService Security Certificate in the computer’s certificate store, you need to export the security certificate from the user certificate store where you saved it above and import it into the computer certificate store.

To export the certificate, on each CCMP database server:

1. In the Start menu, type **mmc** in the command box to open Microsoft Management Console (MMC).
2. Click **File > Add/Remove Snap-in**, click **Certificates**, then **Add**.
3. In the Certificates Snap-in dialog box, select **My user account** and click **Finish** to add the Certificates snap-in to MMC. Click **OK**.
4. In MMC, expand the Certificates – Current User node, Trusted Root Certificate Authorities node, then click **Certificates** to see the available certificates.
5. Locate the certificate you imported in the section above, right-click on it, and select **All Tasks > Export**.
6. In the Certificate Export Wizard, select **Next**.
7. In the Export File Format dialog box, accept the default format and click **Next**.
8. In the File to Export dialog box, specify a file name and click **Next**. Review the settings and click **Finish** to complete the certificate export wizard.

To import the certificate, on each CCMP database server:

1. In the Start menu, type **mmc** in the command box to open MMC.
2. Click **File > Add/Remove Snap-in**, click **Certificates**, then **Add**.
3. In the Certificates Snap-in dialog box, select **Computer account** and click **Next**.
4. In the Select Computer dialog box, select **Local computer** and click **Finish** to add the Certificates snap-in to MMC. Click **OK**.
5. In MMC, expand the Certificates (Local Computer) node Trusted Root Certificate Authorities node, then right-click **Certificates** and select **All Tasks > Import**.
6. In the Certificate Import Wizard, click **Next**.
7. In the File to Import dialog box, browse to the certificate file you exported above, click **Open**, then click **Next** again.
8. In the Certificate Store dialog box, select the option, **Place all certificates in the following store**, then **Browse** and locate the Trusted Root Certificate Authorities store and click **OK** to return to the Certificate Store dialog box.

9. In the Certificate Store dialog box, click **Next**. Review the settings and click **Finish** to complete the certificate import wizard.

**Installing the Security Certificate for ICE Users**

This step is only required if an ICE user wants to be able to test Unified CCE connections using the ICE tool.

To install the certificate in a user’s certificate store, each ICE user must repeat the steps in **Installing the Security Certificate in the User Certificate Store** on Page 125 on the server or servers on which they want to be able to run ICE.

**Unable to Associate Domain User Account with a Supervisor**

When you create or edit a supervisor agent in the web application, you can optionally select a domain user account to associate with the supervisor agent. The available domain user accounts are identified from the Active Directory Organizational Unit that was selected when the equipment was configured in ICE.

If you do not see the domain account you want to use in the list of available accounts, then ensure that, on the Domain Controller, the User logon name has been set for that domain user (see the example here).